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Changes from Previous Documentation 
Here are lists of changes for each version of this documentation.  

v6 – May 5, 2021 
• Chapter 6: updated with Preferences option for single-key Marker set/unset 

• Chapter 17: updated Preparing the MIDI Port in Hauptwerk with a screenshot from the 

current version of Hauptwerk, added a full explanation of the steps required under 

Importing Stoplists with updated details concerning different versions of Hauptwerk. 

Improved chapter text for clarity. 

• Throughout: update images of Preferences Window 

Previous Versions 
v5 – February 12, 2021 

• Chapter 19: added new chapter Project File Handling. 

v4 – December 15, 2020 

• Chapter 2: updated Using Velocity Scaling with new Fixed Velocity option, and added 

section explaining Define Legato Tap Octave option. 

v3.1 – February 20, 2019 

• Chapter 18: updated text for new Sequence options “allow hanging notes” and “end event 

is Note ON”. 

v3 – February 1, 2019 

• Introduction: added step for assigning Sequences (new feature) to Workflow 

• Chapter 2: reworded definition of “Tapping” concerning “levels of complexity” and 

mentioned the new Sequence option as the preferred method for performing music of 

complexity beyond normal performance levels. Added section Extremely Difficult Passages 

to mention the new Sequence option. 

Please report typos or problems with this text via email to hpiinstruments@zentral.zone
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• Chapter 8: added description of trill options (either 7 notes long, or the whole duration of 

an existing note). Added Split & Merge Notes section describing these new editing features. 

• Chapter 18: New chapter added on Sequences (new user-requested/commissioned feature). 

• Throughout: updated images of the Preferences window since it has been reorganised.  

v2 – December 15, 2018 

• Chapter 17: New chapter added to explain all new features added to MIDI Tapper for 

working with Hauptwerk virtual organ software. 

• Introduction: Updated Mac minimum OS version to 10.10.5 (unavoidable) 

• Added this section for quick overview of changes. 

• Added version number and publication date to the page header. 

v1 – October, 2017 

• First release (following two years in beta with no documentation) 
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Introduction  
MIDI Tapper for Mac OSX and Windows allows you to perform music of any level of complexity 
quickly and easily, by playing with just one or two fingers on a MIDI controller. You can record, 
edit, and shape your music with the performance nuances you want, getting results with 
precise control in a fraction of the time it would take with conventional performance and 
recording methods.  

System Requirements 
Mac — OSX 10.10.5 or later 

PC — Windows 7 or later, 2GHz minimum, accelerated graphics hardware 

Features List 

•  imports and exports Type 1 Standard MIDI (.mid) Files * 
•  preserves meta events, patch changes, volume, and panning CCs 
•  built-in microtonal playback 
•  automatic 4-part harmonic analysis based on J.S.Bach Chorales 
•  supports wide variety of tuning file formats 
•  edit MIDI data graphically or in an Events List 
•   special features to support Hauptwerk virtual organ software 
•  score display options: barlines, meters, taps, markers, backgrounds 
•  MIDI Tapper creates a tapping stream by grouping MIDI events 
•  separate any grouped events to suit your performance needs 
•  mark ornaments and flourishes as Rubatos for independent expressive control 
•   sequence passages which are too complicated to tap 
•  customisable note shapes and colors 
•  receive input from any MIDI controller 
•  loop-rehearse any passage 
•  record any number of takes 
•  review and compare takes side by side 
•  splice takes together 
•  reshape velocity histograms 
•  native .miditapper files 
•  automatic and menu-optional bug reporting 

Slower PC processor or graphics hardware results in unacceptable performance.

* MIDI Tapper is compatible only with Type 1 (Multi-Track) MIDI files.
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About This Documentation 
This documentation is written to be read from beginning to end. A summary of the user 
interface is provided in this introduction, which also explains normal workflow. Subsequent 
chapters explore topics in detail. An effort has been made to group related topics together, 
but cross-referencing between chapters is necessary. 

User Interface Basics 
MIDI Tapper has a straightforward, single-window interface with a toolbar for selecting MIDI 
options, recording, playback, various display options, modes, and preferences.

 

Views — Overview, Viewport & Detail 
An area across the bottom of the window (128 pixels tall) shows the entire imported MIDI File. 
This area is called the Overview. In the Overview is a semi-transparent box with a white line 
in the middle. This box is called the Viewport. The contents of the Viewport are shown above 
the Overview in expanded form filling the majority of the window. This area is called the 
Detail View. These displays always show the imported MIDI data, a.k.a. the Source Data. This 
is a very important point to remember. 

The graphic Views in MIDI Tapper always display the imported MIDI 
data, which is referred to in this documentation as the Source Data.
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Moving and Resizing the Viewport 

The Viewport can be moved anywhere within the Overview by clicking 
and dragging it left or right when the cursor is a closed hand icon. 
Dragging with the Control key held allows moving the Viewport in any 
direction (up, down, left or right). Dragging with Control + Shift held 
allows only vertical repositioning.  

When hovering with the mouse over the top, bottom, or right edges of the Viewport, the 
cursor icon changes to an arrow. Clicking and dragging a Viewport edge changes the size of 
the Viewport, and thus changes the contents of the Detail View. The default vertical size of 
the Viewport is determined by the highest and lowest notes in the source file, and the default 
horizontal size of the viewport is determined by the density of events in the source file. The 
Viewport size can also be changed by using Zoom In and Zoom Out menu items Command = 
and Command -. 

Taps — Tap Pointer & Tap Lines 
The white line in the center of the Viewport corresponds to the white line in the center of the 
Detail View. This line indicates where the next Tap will happen, and is called the Tap 
Pointer. In terms of musical time, the Tap Point represents “now”. To the right of the Tap 
Pointer are similar lines called Tap Lines, which show what is coming up next rhythmically. 
Chapter 2 focuses on the Tap concept and provides some tips on tapping technique. 

Toolbar — Left Side 
Buttons on the left side of the toolbar have to do with MIDI playback and recording. 

MIDI — set MIDI Input and Output Ports and Synthesizer Options (see Chapter 1) 
 
Click — turn a Metronome “Click” on or off, or to change the playback or count-off 
tempo. The default tempo shown matches the value found in the imported MIDI file, 
which you can change as needed 

Start — move playback to the beginning of the current Take, or if the current position 
is already the beginning of the current Take, then move to the start of the source file 
(a.k.a. rewind) 

Record — record a Take (see Chapter 11) 

Modify — modify selected notes of a Take (see Chapter 13) 
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Play — from the current tap position, play the selected source file or recorded Take  
 
Takes — (see Chapter 11) select the source file or a Take for playback; rename, 
delete, retake, export, duplicate, copy, or splice Takes; review Takes, or open the 
currently selected Take in a new window 

Conductor — play back a recorded Take via recorded Taps (see Chapter 1). 

Toolbar — Right Side 
Buttons on the right side of the toolbar have to do with display and editing. 

Tracks — show, hide, or select Tracks and Channels; select Note Heights,  
Auto-number Channels per Track (see Chapter 3) 

Score — show or hide barlines, measure numbers, time signatures, Grand Staff lines, 
and background image 

Taps — hide or show Taps; turn velocity scaling on or off (See Chapter 2) 

Markers — hide or show Markers and Marker Lines, select current Marker color and line 
length (see Chapter 6) 

Text — add a Text object at the current Tap Pointer location (see Chapter 6) 

  
Colors — select the color display option; edit and create custom Color Sets (see 
Chapter 4) 

Shapes — assign note shapes to Tracks and Channels (see Chapter 5) 

Analysis — display Chord Symbols, Roman Numerals, Voice Crossings, and Note Names 
for any source data implementing 4-part harmony (see Chapter 16)  

Write — switch from Edit Mode to Write Mode; turn Snap To Grid on or off; select the 
Track and Channel to which to write (see Chapter 8) 

Edit — switch from Write Mode to Edit Mode (the default Mode) 

Prefs — open the Preferences window 

12
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Workflow 
The following steps characterise a typical workflow for a MIDI Tapper recording project: 

1. Import a Standard MIDI file (Type 1 .mid files only) 

2. Test Playback and adjust MIDI Settings and Synthesizer Output. 

3. Tap through the file. 

4. Group / Ungroup notes as needed. 

5. Select appropriate Colors, Shapes, and Note Heights. 

6. Edit the source data as needed. 

7. Assign Rubatos (trills and free rhythms) as needed. 

8. Add rehearsal Markers as needed. 

9. Define Sequences as needed. 

10.Rehearse Passages as needed. 

11. Record as many Takes as needed. 

12. Splice Takes together as needed. 

13. Modify Takes as needed. 

14. Reshape Velocities as needed. 

15. Edit and Export a final Take (as a Type 1 .mid file). 

The terms shown in Bold Italics above comprise the main topics of this documentation. 

Bug Reporting and Feedback 
Please report any problems you may experience with MIDI Tapper directly by using the menu 
item Report a Bug. Before doing so, please also check the MIDI Tapper reports webpage, 
which lists all known issues and feature requests. Please send feedback and suggestions by 
email directly or using the menu item Send an Email.  

Feature Requests 
If the software does not do something you would like it to do, and you are willing to pay for 
the feature you want, use the menu item MIDI Tapper > Request a Feature to describe the 
feature and make an initial offer to pay for it. A professional wage for programming is not 
expected. 20 € is an acceptable starting point, considering that adding any feature requires 

Kindly do not post complaints in Mac App Store Reviews, as there is no way to 
correspond with you to correct the problem in that case. When you report a bug 
directly as described above, support will proceed via email to resolve the issue. 
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many hours of work. If your offer is reasonable, your idea makes sense, and the feature could 
conceivably benefit many users, then a payment schedule is agreed upon and a testing stage 
begins. Once testing is done and the feature is verified as working, a new version of the 
software is released including the new feature. 

Crowd Funding 
For ideas that will benefit many users, it makes sense to combine resources to pay for the 
work. At present there is no mechanism for doing this in an organised way, but it would be 
possible to build a system into the H-Pi website for all registered users of the software to 
combine resources for feature requests, or possibly use an existing crowd-funding platform. If 
this sounds like a good idea to you, please share your support for it with others and send any 
suggestions you may have for its development and implementation. 

Not all features are possible or will be considered relevant for the majority 
of users. A minimum offer of 20 € is suggested for all Feature Requests.

14



Ηπ INSTRUMENTS           hpi.zentral.zone       ·       MIDI Tapper      ·     documentation v6     5.May.2021

1. Importing and Playing Back MIDI Files 
A MIDI Tapper (.miditapper) Project begins by importing a Standard MIDI (.mid) file which is 
referred to as a source file. It is assumed that the user is familiar with MIDI files. Resources 
for learning about MIDI are available online at midi.org 

Importing a MIDI File 
To import a MIDI file, type Command-I or select the menu item File > Import MIDI File. The 
file should be a Type 1 (multi-track) MIDI file. Type 0 files may import without error, but the 
data will not display properly. The Takes toolbar button will indicate that a MIDI file has been 
imported by displaying a star. 

          Before Import        After Import 

MIDI File .mid Import Preferences 
A Type 1 MIDI File consists of one tempo track (Track 0), and one or more voice tracks. The 
tempo track is imported without filtering any of its data. The data read from each voice track 
depends on which options you choose in the Preferences Window under the .mid import tab. 

• Note ON / OFF 
• Patch change 

• Volume CC 
• Panning CC  

• Meta events 
• Pitch Bend 

Timing Threshold for Taps 
By default MIDI Tapper will group together MIDI events which share common event times. 
When events are not all exactly aligned in a MIDI file (for example, from a MIDI recording of a 
live performance), events can be grouped together within some timing threshold by selecting 
Use Time Threshold for Tap Grouping in the Preferences window. 

Categorical Tempo Text 
To display a tempo indication for imported MIDI files, check that option in the Preferences 
Window under the Display tab. Note that such indications may not be musically accurate. 

Possible Import Parsing Issues 
MIDI Tapper has been tested with a wide range of MIDI files, but not all MIDI files are created 
equally. Particularly if you are not the creator of the MIDI file (for example, if you found the 
file on the internet) please beware that some files may contain data that will not parse 
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correctly in MIDI Tapper. If you experience a problem with a specific MIDI file that you know is 
properly formed, please send an email to hpiinstruments@zentral.zone explaining the 
problem, including the MIDI file as an attachment. 

Possible Post-Import Issues 
If you have created a source MIDI file, it is assumed that you have organised the tracks and 
channels the way you want them; however, if you are working with a MIDI file you did not 
make yourself, one of the first things you should do is to look at the Track and Channel 
structure of the file and take careful note of how it is organised (see Chapter 3). 

During Beta Testing, MIDI files from many diverse sources were imported into MIDI Tapper. 
Several problems with MIDI files which parsed correctly but nonetheless confused users were 
found. Here is a short list of things to look out for in MIDI files that you have not made 
yourself: 

1. duplicated tracks 
2. inconsistent tracks and channels 

3. temperament tuning channels 
4. rotating channels 

1. duplicated tracks — In a MIDI file, the same MIDI data may be duplicated on two or more 
tracks. This is sometimes done with keyboard tracks in order to strengthen the output, or 
double octaves via patch layering rather than note transposition (such as sending the same 
data to several organ stops at once, as would be the case in real organ registration). In this 
case, MIDI Tapper will display notes from different tracks on top of each other, and it is not 
possible to see at a glance that several tracks contain identical data using the default shape 
(Rectangles). It is therefore a good idea after importing a file that you did not create, to click 
the Tracks button and compare the number of tracks listed there to the number of tracks you 
can see displayed. If the number of tracks is greater than you can see, try showing and hiding 
tracks, or assigning unique note shapes to each track. Finally, delete any duplicate tracks. 

2. inconsistent tracks and channels — Some MIDI files may have data haphazardly 
(illogically) shared between any number of tracks and channels. Within MIDI Tapper it is 
possible to reassign notes to different channels and tracks, but for large files having a lot of 
haphazard note assignments, it will make more sense to edit the file in some other software, 
look for an alternative MIDI file, or simply make a new MIDI file from scratch yourself. 

3. temperament tuning channels — Some MIDI files are made with 12 tones in any octave 
separated onto 12 MIDI channels. This is done in order to output in a 12-tone tuning other 

Type 1 MIDI files improperly containing note data on Track 0 are corrected on import.
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than 12-tone Equal Temperament. This problem can only be solved by manually selecting 
notes and assigning them to desired tracks and channels. 

4. rotating channels — Some MIDI files are made with each next note of a track output on a 
different channel. This is a technique used to achieve microtonal output, where each note is 
preceded by pitch bend data. (Because pitch bend is a MIDI channel message, each next note 
needs to be sent to a new MIDI channel.) While this is a practical solution for getting 
microtonal output from a MIDI file, it is not ideal for working in MIDI Tapper. The problem can 
only be solved by selecting notes and assigning them to desired tracks and channels. For large 
files, it may be easier to use a separate application for this type of editing. 

Reimporting a MIDI File 
Sometimes after importing a MIDI file, it becomes apparent that the source file needs to be 
edited. Although MIDI Tapper does provide basic editing functions, often it will make more 
sense to use the application which created the MIDI file (such as a notation program) to edit 
the file. For these cases, MIDI Tapper provides an option to Reimport a MIDI file that has been 
previously imported. Since editing can sometimes require several iterations (tweaking), the 
idea is to save time by not having to go through the import dialog and select the same file 
every time for importing. Reimporting retains Markers and Hauptwerk registrations.  

Advice on Creating MIDI Files for MIDI Tapper 
Source files for MIDI Tapper should contain data corresponding exactly to a musical score, as 
opposed to a MIDI recording of a live performance. To optimise a score-data source file for 
MIDI Tapper, make sure the file is multi-track. Type-1 MIDI having only a tempo track and one 
other track containing all the data are not ideal, because voices are then difficult to isolate. 
Staves and voice ranges should be separated into individual tracks. A piano piece should at 
least be separated into tracks for the treble and bass staves. To simplify synthesizer output, 
the notes of each track should be assigned to the same channel number as the track; for 
example, notes on track 3 should be assigned to MIDI channel 3. The menu item Tracks > 
Auto-number Channels per Track can be helpful in this regard (see Chapter 3). 

Setting up MIDI Preferences 
In order for MIDI Tapper to work properly, you must set up your MIDI Input Source and 
Output Destination. To do this, click the MIDI icon in the toolbar, or select the menu 
MIDI > Input / Output. If you change anything in your MIDI setup while MIDI Tapper is 

open, and you want to connect to the newly connected device(s), you must open the MIDI 
window and click Rescan to see the newly connected device(s) in the input or output lists. 

IMPORTANT: Selecting the same MIDI Port as both the Input Source and the Output 
Destination creates a MIDI Feedback Loop, which will crash the application.
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Apple DLS Synthesizer 
On computers running OSX, a default output synthesizer is provided by Apple which supports 
Soundfonts. This synthesizer also supports monotimbral GM microtuning (see Microtonal 
Playback, below). Mac users can begin using MIDI Tapper with immediate output results by 
selecting this synthesizer as the default MIDI Output Destination. 

Windows GS Wavetable Synth (Latency Problems) 
Windows users with standard installations of Windows are at a distinct disadvantage compared 
to Mac users, because the default Microsoft synthesizer for Windows has an output latency of 
around half a second. The extremely poor performance of this synthesizer makes it basically 
unusable as a MIDI Output Destination for MIDI Tapper. Windows users are encouraged instead 
to send MIDI output to an external hardware or some other software synthesizer. While virtual 
MIDI ports are standard on Mac OSX, Windows users must install a virtual MIDI router such as 
MIDI Yoke or LoopBe1 to allow sending MIDI to another application. 

Multitimbral Playback 
Multitimbral source files will only play back properly when MIDI is sent to a multitimbral 
Output Destination. On Mac, by default the Apple DLS Synthesizer is multitimbral. On 
Windows, the default Windows GS Wavetable Synth is also multitimbral, but due to latency 
this synthesizer is not usable for live tapping. (It may be usable for playing back the source 
file and any recorded Takes). 

MIDI Synth Options window 
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The MIDI Synth Options window is available for easily selecting the Patch, Volume, and 
Panning of each MIDI output channel. Only the MIDI Channels in use by the current file are 
shown in the list. Channels are not differentiated by track, so for example Track 1-Channel 1 
and Track 2-Channel 1 are both listed as Channel 1. This means that you must assign unique 
channel numbers to the voices your source file in order to allow unique output timbres per 
voice. To save you trouble some cases, a convenience function Auto-number Channels per 
Track is available via the Tracks button (see Chapter 3). 

For Mac users, when the Apple DLS Synth is selected, parameters for SoundFont, global Pitch, 
Reverb, and Volume are also available. Synthesizer settings can be stored and retrieved to 
save time preparing output with frequently used settings. The most frequently used 
synthesizer settings can also be saved as a default in the Preferences. 

Microtonal Playback 
 Check the Tuning checkbox in the MIDI Synth Options window to configure MIDI 

output for GM microtonal playback. Note that in this mode, the output will always be 
monotimbral. MIDI Tapper supports seven types of tuning files .scl, .csv, .hz, .tun, .mtx, .gly, 
and .tonex (see Appendix). For multitimbral microtonal playback, output from MIDI Tapper 
can be sent to microsynth. 

Playing Back a Source File 

When the Takes icon shows a star, the imported source file is ready for playback. 

 

Click the Play button to play back the source file. Click it again to stop playback. 
 

Playback begins at the current Tap Pointer location. Clicking the Start button moves 
playback to the beginning of the file. 

The Tempo of Take playback can be changed under the Click menu. 

During playback, rather than scrolling, the display shows the music which is currently playing, 
changing only when necessary.  

Animated playback is also available through the Conductor. Be sure to 
understand the difference between recorded MIDI data and source data before 
using this function (see Chapter 8). 
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2. Tapping Basics 
Once you have imported a file successfully and configured MIDI Settings, you are ready 

to start making music. The basis of musical performance in MIDI Tapper is a single key-press 
on a MIDI controller * called a Tap. Tapping is defined as follows: 

* A computer keyboard can also be used, but the results are less expressive. 

The language above “normal range of complexity” refers to music which would normally be 
described as playable in the normal way on an instrument. For music which is too complex for 
human performance, or too complex for tapping for whatever reason, the Sequence can 
should be used (see Chapter 19). 

Tap Groups 
A piece of music typically consists of rhythmically organised notes, written as single lines 
(melodies), or groups (harmonic intervals and chords). Single notes, harmonic intervals, and 
chords all share this in common: each requires only one position in a score. Note positions in 
a score are converted to note times in a MIDI file. This leads to the concept of Tap Groups. 

* see Timing Threshold for Taps above, and Grouping and Ungrouping Taps, below. 

Including MIDI Patch Changes, Volume, Panning, & Pitch Bend 
In the Preferences Window, Patch changes, CC events, and Pitch Bends occurring at the same 
time as any Note(s), can also optionally be included in Tap Groups by selecting these options 
on the .mid Import page. Note that changes made to these settings apply only to source files 
imported after the settings have been changed. MIDI messages included in a tap are shown 
with a MIDI icon. The included messages can be viewed and edited by clicking on this icon. 

Tapping is a computer-assisted approach to performance in which music within a 
normal range of complexity can be performed using only one key on a MIDI controller.

A Tap Group (or loosely just Tap or just Group) is a collection of one 
or more Note ON events happening at the same time* in a MIDI file.
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Using Velocity Scaling 
A Group of notes does not necessarily have a uniform dynamic level; i.e. one note in a chord 
may be played with a louder dynamic than the others. MIDI Tapper accommodates this musical 
requirement by combining the dynamic of the Tap with the dynamics of the notes in the Tap 
Group when Source scaled by Tap is selected in the Preferences Window. The loudest note in 
the Group is scaled to equal the Tap velocity, and the other notes in the Group are scaled 
proportionally, for a natural-feeling response which allows expressive control of the dynamic 
relationships existing in the source file. 

 
Tap velocity can also be given by the Tap input only, or the Source only (unscaled). In cases 
where you have a velocity sensing input controller but need a result which does not vary in 
velocity, you can use the option Force MIDI Inout Velocities to fixed value. 

Legato Tap Octave 
MIDI Tapper’s automatic handling of note releases may sometimes give an effect which is too 
uniform. For solo lines in particular, fine control over the release of each note and the ability 
to overlap notes in a legato phrase can be musically important. Use the option Define Legato 
Tap Octave to have fine release control when tapping with a specific octave of keys. 
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Muting Doubled MIDI Notes 
This option is included for polyphonic keyboard music in which two voices on different MIDI 
channels sometimes play the same note at the same time. Some synthesizers (such as the 
Apple DLS Synthesizer) will respond to this by doubling the output sample for that note, giving 
an unnaturally loud result, so that doubled notes “stick out”. Muting one of the notes solves 
this problem. If both notes are of the same length, the note with the smaller channel number 
gets muted. If one note is longer than the other, then the shorter note is muted. You can set 
this property for individual notes by Right-Clicking on the note and selecting Playback > Skip 
or Play. 

Grouping and Ungrouping Taps 
MIDI events in a source file which occur at the same time, or within some timing theshold of 
each other, are collected into Tap Groups. If Tap Groups happen to be created very close 
together, and you would prefer them to be combined into a single Group, there are some 
keyboard shortcuts and menu options to help you make the Tap Groups the way you want 
them. The many ways that notes can be selected are explained in Chapter 7. Menu shortcuts 
are summarised below. 

* Note that if you select notes which are far apart and try to Group them together, MIDI 
Tapper may not be able to place them into a Tap Group. In that case, you will either have 
to select notes and nudge them left or right in order to align them close enough for them 
to be able to be grouped together, or simply use one of the other grouping shortcut 
options. 

If notes have been grouped together which you prefer to separate (for example, to play a 
chord “rolled” instead of “straight”) there are Ungroup menus and shortcuts for this purpose. 

Menu Item Keyboard Shortcut Description

Taps > Group Command-G Group Selected Notes *

Taps > Group with Next Command-Option-G
Combine the Tap Group at the 
current Tap Pointer location  

with Next Tap Group

Taps > Group with Previous Command-Shift-G
Combine the Tap Group at the 
current Tap Pointer location  

with Previous Tap Group
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Inserting Empty Taps 
Sometimes a passage may be easier to tap when its rhythm is made more uniform. This can be 
done by inserting an Empty Tap (or several Empty Taps) into the Tap Stream. An Empty Tap 
functions the same as a normal Tap from a tapping standpoint, but it contains no notes. An 
Empty Tap can be inserted by clicking at the desired insert location and selecting the menu 
item Taps > Insert or by Right-Clicking in the desired insert location and selecting Insert 
Empty Tap from the popup menu. Below, a passage from J.S. Bach’s Der Kunst der Fuge is 
shown before and after an inserted Empty Tap is inserted via Right-Click to make the tap 
stream rhythmically uniform. 

  Before        After 

Menu Item Keyboard Shortcut Description

Taps > Ungroup > Upwards Command-U

Separate the notes of a selected 
Tap Group from the bottom up 

(normal direction for a  
“rolled chord”).

Taps > Ungroup > Downwards Command-Shift-U

Separate the notes of a selected 
Tap Group from the top down 

(reverse direction for a  
“rolled chord”).

Taps > Ungroup > With Options (none)

Separate the notes of a selected 
Tap Group from the bottom up, 
or from the top down, with a 
specific span of time between 

the notes.
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Sustain Pedal Behaviour 
Sustain CC messages are not read from source files. Depressing and lifting a sustain pedal is 
considered a real-time parameter which should be able to be inserted anywhere into a tapped 
performance, as would be expected when playing a midi keyboard in the conventional way. 
Behaviour of the sustain pedal during tapping is as would be normally expected. When the 
pedal is depressed, all notes continue to sound. When the pedal is raised, notes which have 
been released stop sounding, and notes which are still held continue sounding. If you find that 
your sustain pedal behaves in reverse with MIDI Tapper, simply open the MIDI Input/ Output 
window and change the state of the Sustain ± checkbox. 

Legato Source Data 
Some MIDI files are made using a 100% note length paradigm. This means that Note OFF 
events will happen exactly at the same time as Note ON events in the MIDI file. The output of 
such data is legato when tapped (sounding notes overlap), which may not be what you want. 
To fix this problem, use Select All and then Right-Click and select Force Non-Legato. MIDI 
Tapper will then shorten all the selected notes just enough so that Note OFF events occur 
before Note ON events, as would normally happen in a non-legato performance. 
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Trills and Free Rhythms 
Passages containing trills, turns, and other free ornaments or cross rhythms may be difficult 
to perform, or may sound too “square” when tapping. MIDI Tapper provides Rubatos as a 
means to handle these situations (see Chapter 9). 

Extremely Difficult Passages 
For passages that are too difficult to tap either in the normal way or using Rubatos (see 
Chapter 9), MIDI Tapper provides Sequences. Groups assigned to a sequence will play back 
automatically without having to tap the rhythm (see Chapter 18). 

Advice for Tapping 
It is recommended that a high quality velocity sensing MIDI keyboard controller be used for 
tapping, but many different kinds of controllers can be used. Keep in mind that different 
passages of music can also be realised in various ways using a variety of tapping techniques.  
The following list of things to try out refers to the use of a standard MIDI keyboard. If you are 
using an alternative controller, try coming up with equivalent variations for that controller. 
Experiment and see what works best for you. 

SOME IDEAS: Try tapping with … 

• 1 finger only 

• 1 hand only, multiple fingers 

• 2 hands alternating, 2 fingers 

• 2 hands alternating, multiple fingers 

• white key(s) only 

• black key(s) only 

• white and black keys 

• always same keys 

• always different keys 

• scale patterns 

• etc. 

Before recording a take, tap through the music to find out what works and where difficult 
passages may require rehearsal or eventual splicing. The following chapters explain important 
concepts that will help you prepare your files for recording. 
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3. Notes, Tracks & Channels 

MIDI Tapper displays MIDI notes corresponding to different properties. After importing a MIDI 
file, you have control over note the MIDI properties of the notes (Pitch, Velocity, Track, and 
Channel assignments) as well as display properties (Color, Shape, and Height). 

MIDI Properties of a Note 
Four basic properties of a MIDI Note are: Pitch, Velocity, Track, and Channel. The Pitch value 
is changed by dragging the note up or down. To change the Track, Channel, or Velocity of a 
note, simply Right-Click on the note and select Edit Note Properties > A popup menu will 
appear, showing you these note properties, as well as other information and options. More 
information on editing these and other MIDI properties of notes is given in Chapter 8. 

Display Properties of a Note 
MIDI Tapper adds three display properties to each Note, the first of which, 
Color, corresponds to MIDI data. Notes are displayed by default with colors 
according to Track and Channels. To change the color of any note directly, 
simply Right-Click on the note, and choose the menu item Edit Note 
Color… to open a standard color picker window allowing you to choose any 
color for the note. Depending on which Color Display Option you are using, 
all notes sharing the same property will also change to the selected color. 
When using one of the default Color Sets, you will then be prompted to 
name a new Color Set. When using a Color Set you have created, the Color 
Set is simply modified and saved. Set Default Note Colors for new 
projects in the Preferences. To get an idea of various possibilities, try the 
menu item Display > Random Note Colors. Complete information on Color 
Display Options and Color Sets is given in Chapter 4. 
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The Shape of the note is also visually important. Notes are displayed by default as Rectangles. 
To change the shape of any note directly, simply right-click on the note, and selecting Edit 
Note Parameters > Shape > to open a cascading menu of choices for different note shapes. 
Shapes for new projects are defined in the Preferences window under the Notes tab. To get 
an idea of various possibilities, try the menu item Display > Random Note Shapes. Complete 
information on Note Shapes is given in Chapter 5. 

The appearance of some note shapes can be altered by assigning a note Height property. 
Below, three different settings are shown for all tracks side by side for the default note shape 
left-aligned Rectangles.  
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A note height of 1.0 means that the note occupies the space of an equal fraction of the 
vertical span of the Viewport. For example, if the Viewport spans 50 notes, then the default 
note height (1.0) is equal to 1/50 of the vertical height of the Detail View. Although this 
property applies to notes, it is assigned per Track. You may want to change the note height in 
order to more easily distinguish tracks at a glance, to increase the height of stretched Shapes 
(see Chapter 5), or you may want to change the note height of all tracks at once. The note 
height of an individual Track, or all Tracks together, can be changed under the toolbar menu 
Tracks > Note Height. You can also choose a Default Note Height in the Preferences. To get 
an idea of various possible combinations, try the menu item Display > Random Note Heights. 

Set Playback — Play / Skip 
Every note has a Playback property which you can set arbitrarily. By default, the playback 
property for all notes is Play. A note can be muted by changing the Playback property of the 
note to Skip. As mentioned in Chapter 2, selecting Mute doubled MIDI notes in the 
Preferences will tell MIDI Tapper to when importing files to handle cases where different 
channels have the same note at the same time by setting the Playback property of one of the 
doubled notes to Skip. 

Tracks & Channels — Show / Hide, Select 
The Tracks and Channels of an imported MIDI file can be selected, shown, or hidden 
by clicking the Tracks toolbar button and choosing the corresponding menu item. It 
is possible to select an entire Track or only one Channel from a Track. For files 
having more than one track, it is also possible to selectively show each track alone 

using the keyboard shortcuts Command-1, Command-2, Command-3, and so on. 
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Auto-numbering Channels per Track 
As mentioned in Chapter 2, synthesizer output differentiates timbres by channels, so that 
settings are simplified when voices have unique channel numbers. The menu item Tracks > 
Auto-number Channels per Track can save you time by uniquely numbering all existing 
channels per track. For example, if all tracks contain only one channel, then selecting this 
option will assign notes on Track 1 to Channel 1, notes on Track 2 to Channel 2, and so on. For 
multiple channels per track, the channels are simply numbered in ascending order starting 
with Track 1. In some cases you may want to separate notes on a given track into some other 
channel configuration. In those cases, MIDI Tapper cannot automate the task as it cannot 
know which notes you want to assign to which channel, so you will have to select notes and 
assign the channels manually. There are many different ways to select notes, which can still 
save you some time in these cases (see Chapter 7). 
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4. Color Display Options & Color Sets 

In MIDI Tapper, you have control over the display colors used to represent MIDI note 
properties. There are many ways to do this. MIDI Tapper provides six different 
default options, and allows you to create your own custom Color Sets according to 
any of these six general patterns. 

Custom Color Sets 
The creation of Custom Color Sets is handled through the Preferences window; screenshots 
are therefore shown below to explain the logic behind each default option. When creating a 
Color Set in the Preferences window, simply click on each color box to assign a new color. 

Color by Tracks & Channels 
This is the display option used by default, and is intended to provide reasonable 
differentiation between Tracks and Channels. When this option is chosen, each Track is given 
its own color, and each Channel of each Track is also given its own color. The Channel colors 
of different Tracks will not match each other, or they will match only coincidentally. 

Color by Tracks Only 
When this option is chosen, each Track is given its own color, and all Channels in that Track 
are given the same color. This can be useful for working with MIDI files having haphazard 
channel assignments. (The input scheme in the Preferences window looks the same as Tracks 
& Channels.) 

Color by Channels Only 
This scheme gives unique colors to Channels of the same number, regardless of Track. This can 
be useful for determining MIDI output options, since output is limited to 1 MIDI port having 16 
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Channels. (The input scheme in the Preferences window looks the same as Tracks & 
Channels.) 

Color by Velocities 
MIDI Velocity values range from 0 to 127, where a value of 0 means the note does not sound at 
all. Representation of these values by color is done using a gradient of five colors with three 
moveable “hotspots”. 

To change the position of a “hotspot”, simply click and drag the number under any of the 
three inner boxes. This is useful for assessing the velocity distribution of a Take at a glance, 
and can be helpful when working with Velocity Scaling (see Chapter 2). 

Color by Notes (chromatic) 
When working with files that have all notes organised into only one Track and one channel, it 
can be useful to assign note colors by pitch. In this case a chromatic pattern is a logical 
option.  
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Color by Notes (5ths) 
An option to assign colors according to a cycle of fifths an alternative to chromatic note 
coloring for projects having only one Track and channel. 

Changing the Color Display Option 
The menu item Display > Random Note Colors can give you ideas for using various color sets. 
To choose colors deliberately, click the Toolbar Colors button to choose which Color Set you 
want to apply to your project at any time. Any custom Color Sets you have created are 
available as submenus according to the paradigm used for the Color Set. For example, below 
is shown a custom Color Set called “My Fifths”, available as a submenu under Notes (5ths). 
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5. Note Shapes & Background Image 

MIDI Tapper defaults to displaying note data using rectangles — a simple form and a 
traditional default shape for graphic note display in MIDI software. In addition to 
Color (see Chapter 4) and Note Height (see Chapter 3), different note shapes can 
help to reflect the character of a piece of music, giving the score a more exciting 

appearance which may even influence how you perform the music. Different shapes in 
combination can be useful for distinguishing one voice from another particularly when voices 
overlap. The default black background can also be replaced with an image.  

Shape Groups 
MIDI Tapper offers seven types of note shapes, with options for center or left horizontal 
alignment, and sometimes also with orientation and deformation options. Six shape types are 
shown in the table below in “large” form, followed by a large right-facing triangle and two of 
its type variations. 

Rectangle Circle Square

Diamond Hexagon Octagon

Triangle … Isosceles … Right
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Stretched vs. Large Shapes 
The table above shows mostly large shapes, which correspond to forms one would normally 
expect. Notice that among all the shapes shown, the Rectangle, Isosceles Triangle, and Right 
Triangle all occupy much less vertical space than the other shapes. This is the concept of the 
“stretched” shape. 

The classic MIDI Note rectangle can be seen as a square that has been horizontally 
“stretched”. Other shapes which occupy the same vertical space as the rectangle can also be 
thought of as “stretched” versions of the larger regular shapes. Stretched versions of the 
Circle (oval), Diamond, Hexagon, and Octagon are shown below. 

These shapes work well as replacements for the rectangle, since they occupy the same 
vertical space, the vertical position of the note is just as clear as when a rectangle is used. 
You can also change the vertical size of these shapes using the Note Height property (see 
Chapter 3) so that they appear to be “less stretched”. 

Each shape has a unique visual appeal and overlaps in different ways. Consider this passage 
from J.S. Bach’s “Italian Concerto” BWV 971, shown below in standard Rectangles. 

Stretched Shapes

Circle (oval) Diamond Hexagon Octagon
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The overlapping yellow and green notes can be made more distinct by using different shapes, 
such as stretched Diamonds … 

… or Large Triangles, left-aligned (tap lines not shown) … 
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… or Large Circles, center aligned. 

Assigning different shapes to each voice can also help to see the counterpoint more clearly. 
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Alignment 
In some of these examples, shapes are aligned on tap centers. The normal expectation is for 
the shape of the note to align with the onset of the note, and this is the default alignment for 
the classic Rectangle. When a shape positions its center at the note onset, the tap line will 
bisect the shape, which may sometimes be visually helpful, though note duration is not shown 
as intuitively as when shapes are left aligned. The passage from BWV 971 is shown below with 
large Diamonds center aligned on the tap lines. The Diamond shape shows no overlapping. 

Compare this with Squares, left aligned on the tap lines, which overlap here and there.  

There are of course many possibilities for mixing and matching various Shapes, alignments, 
Colors, and Note Heights. Experiment to find out what works best for your project. 
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Selecting Shapes  
The menu item Display > Random Note Shapes may give you some ideas for combining 
shapes in different ways. Clicking the Shapes toolbar allows you to select shapes for each or 
all tracks and channels from a popup menu.  

Shapes may also be set directly by right-clicking on any note in the Detail View, and selecting 
Edit Note Parameters > Shape >  

38



Ηπ INSTRUMENTS           hpi.zentral.zone       ·       MIDI Tapper      ·     documentation v6     5.May.2021

Shapes for new projects are defined in the Preferences window under the Notes tab. Click 
the triangle to the left of the field at the bottom of the window to select your preferred 
default note shape. 

 
 

Fade In / Fade Out 
Note shapes can be displayed with progressive transparency, either to “fade in” from the right 
side, or “fade out” on the left side, or both. Select the desired option under the Score  
toolbar item. 

Background Images (.jpg or .png only) 
The default black background displayed behind the notes may be replaced with a .jpg or .png 
image.  
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As you tap through a project, the background image will scroll very subtly from right to left. 
Keep in mind that busy images do not work well, since they obscure the notes. Images with 
large relatively uniform areas, such as pictures of the sky or the ocean, will work well. 
To add an image, click on the Score toolbar button and selecting Background Image … and 
navigate to the image file. Note that the aspect ratio of the image is altered to fill the entire 
window space, so images with approximately the aspect ratio you work with will look most 
natural. The image should in any case be of adequate size and resolution to fill the main 
window. Once added, the image can be saved with the project. 

To replace or remove a background image, simply Right-Click anywhere on the background 
and select Background Image > Replace … or Background Image > Delete. 

Adjusting Background Image Brightness 
Many background images will need to have brightness adjusted so that note shapes are not 
too difficult to see. To adjust the image brightness after adding the image, simply Right-Click 
anywhere on the background and select Background Image > Adjust Brightness … A slider 
control will appear allowing you to adjust the brightness in real time. 
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6. Marking and Annotating 

Musicians often make performance notes in rehearsal scores. MIDI Tapper gives you tools to 
help you annotate projects, so that you can perform the music as you have envisioned. 

Markers 
Sometimes you want to mark places in the music according to the form of the work, or to 
remind yourself of where you need to begin tapping a section, so that you can get there 
faster. MIDI Tapper lets you do this with Markers — vertical lines with numbered triangular 
bases. Markers also allow you to select large ranges of notes easily for rehearsing and editing. 

  
To help differentiate Markers at a glance, you can make them of different lengths and colors.  
Once a Marker is set, you can jump directly to the marker by typing the number of the 
marker. For example, typing 1 moves the Tap Pointer directly to Marker 1. When there is more 
than one Marker, you can also move from one Marker to the next using the Command key plus 
Left Arrow and Right Arrow keys. 
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In the Preferences window you can control the default Marker length, color, and Text color, 
under the Display tab. 

 
To add or remove a Marker, type Command-M or select the menu items Markers > Set or 
Markers > Unset. To set or unset Markers with a single keystroke, check the Set via Enter/
Return option. The Marker will be placed at or removed from the current Tap Pointer 
location. After adding a Marker, its length and color can be edited by right-clicking on its 
triangle and making a selection from the popup menu. 
 

You can also hide or show all Markers, or change the working length and colors for new 
Markers by clicking on the Markers icon in the Toolbar. 

Texts 
For specific, freely positionable performance reminders, Text objects are available. The Text 
window provides options for selecting the font, size, alignment, color, margin, line height, 
and rotation angle for your text. Standard musical markings for Tempo, Dynamics, and Style 
are included to save time in cases where you want to copy such markings from a score. 
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Text objects appear in a semi-transparent rounded-
corner box (which can be made invisible by 
setting opacity to 0%). Texts and Markers can be 
combined to clarify performance directions, for 
example reminding yourself to tap a certain 
section on the black keys. To edit or delete a 
Text object, Right-Click the Text and select the 
desired option from the popup menu. 

In addition to Markers and Text annotations, you 
may need to make changes to note durations, or 
you may want to have more freedom and 
expressivity in some passages. The next two 
chapters explain various ways note selections can be made and how the Tap Stream can be 
divided if desired. 
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7. Selection Basics 

Grouping and ungrouping notes as discussed in Chapter 2, as well as other basic actions, 
require selecting notes. Several ways to do this are explained below. 

Selecting by Marquee 
The most intuitive method of note selection is simply to drag a marquee box using the mouse 
cursor. Notes must be completely within the box in order to be selected. You can add notes to 
an existing selection using the Shift or Command keys. To remove notes, use Shift or 
Command and marquee the notes you want to remove. 

Selecting Using Menus and Shortcuts 
Sometimes it takes too long to select notes only by dragging a marquee box. For these 
situations, the following menu items with keyboard shortcuts are available. 

Note that Select All Following and Select All Previous and Select Within Markers depend on 
the position of the Tap Pointer. 

Menu Item Keyboard Shortcut Description

Edit > Select All Command-A Select all notes

Edit > Select All Following Command-Option-A
Select all the notes to the  

right of the Tap Pointer

Edit > Select All Previous Command-Shift-A
Select all the notes to the left  

of the Tap Pointer

      Edit > Select From … To     Command-Shift-
Option-A

Select all the notes between  
two selected notes

     Edit > Select Within Markers     Command-Option-M

Select all the notes between  
two markers, or between a 

marker and the beginning or end 
of the file

44



Ηπ INSTRUMENTS           hpi.zentral.zone       ·       MIDI Tapper      ·     documentation v6     5.May.2021

Edit > Select From … To 
This selection option is intended for situations where a desired selection must be made from 
a given note to another note, but the ends of the selection do not easily fit into the Detail 
View. Although it is possible to resize the viewport so that any number of notes are shown in 
the Detail View, it is usually impractical to do that. Using this option, you only need to select 
a starting note, and an ending note. Usually this means you will select a note, then move the 
viewport to another location, so that you can select the another note, then use the menu or 
keyboard shortcut which selects all the notes in between for you. 

Edit > Select Within Markers 
If you have added Markers to your project, you can use Edit > Select Within Markers or 
Command-Option-M or Right Click > Select Within Markers to quickly select all notes 
existing between one marker and the next.  

Note that this function behaves as if invisible Markers exist at the beginning and end of the 
project, so if you position the TapPointer to the left of your first marker and choose the 
function, all notes from the beginning up to the first Marker will be selected. Likewise, if you 
position the TapPointer to the right of your last marker and choose the function, all notes 
from the last Marker through to the end of the project will be selected. 
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8. Source Data Editing 

Although it usually makes more sense to edit the source data in the software that you use to 
create the MIDI file (such as music notation software) before importing it into MIDI Tapper, 
sometimes you may want to do some light editing of the imported MIDI data such as moving 
notes around or changing durations. MIDI Tapper provides intuitive ways for doing those 
things. You may also sometimes want to write new notes into the score; for example, to add 
ornaments. A special mode called Write Mode is also provided for that purpose. 

Editing Note Properties 
Please see Chapter 3 which covers this subject as well as how Track and Channels impact the 
way you work with Source Data. 

Drag-Editing Notes 
When you mouse over a note, it appears illuminated, and the cursor changes to an open hand 
icon. You can then click on the note and drag it up or down to change its vertical position 
(Pitch), or reposition the note horizontally by holding down the Shift key and dragging the 
note left or right. When you mouse over the right edge of the note, the cursor changes to 
left/right arrows, allowing you to change the Duration of the note by dragging the edge to 
the left or to the right. A rectangle will appear when notes have been assigned other shapes. 

     Mouse over note : Position  Mouse over right edge : Duration    

Copying, Cutting, Pasting, or Deleting Notes 
Notes can be copied, cut, or pasted using the standard edit menu items and shortcuts, or 
through the Detail View Right-Click menu. Deleting notes is also available from both menus, 
but does not have a corresponding keyboard shortcut. 

Mouse Action Changes

over note Click & Drag Vertically Pitch

over note Hold Shift, Click & Drag Horizontally Rhythmic placement

over right edge Click & Drag Horizontally Duration

46



Ηπ INSTRUMENTS           hpi.zentral.zone       ·       MIDI Tapper      ·     documentation v6     5.May.2021

When a Take is selected in the toolbar (the Clapboard icon displays a number), these standard 
editing options are only available from the Right-Click menu under the Source Data 
submenu. If you need to edit the source data after having recorded a Take, see Chapter 8 for 
important concerns that must be considered in that situation. 

Split & Merge Notes 
When editing there may be cases where you need to convert (split) one note into two notes, 
or you may want to combine (merge) two notes into one note. Simply select the notes you 
want to split or merge and Right-Click to open the edit menu, then select Split Notes or 
Merge Notes under the Source Data submenu. 

Write Mode 
Click on the Write toolbar button to enter Write Mode. As a shortcut, you can also 
simply type W on the computer keyboard. Once in Write Mode, the Write toolbar 
button is illuminated and includes a disclosure triangle as shown at left.  

When you click the Write toolbar button while in Write 
Mode, a popup menu appears with options to select the 
MIDI Track and Channel in which to write. The Snap To 
Grid controls whether notes written will automatically 
position themselves into rhythmic subdivisions or not. This option is also a global setting you 
can change in the Preferences. 

Action Keyboard Shortcut

Cut Command-X

Copy Command-C

Paste Command-V

Delete (none)
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The Write Mode Toolbar 
In Write Mode, a semi-transparent toolbar appears at the top of the Detail View with items for 
writing individual notes, ornaments, and MIDI Events. 

Select items in the toolbar by clicking on them, or by typing shortcut keys on the computer 
keyboard. The upper left corner of each item in the toolbar shows the shortcut key which 
selects the item. Each item is explained in the table below. 

Item Description Shortcut Function

Cursor C Temporarily edit while remaining in Write Mode

Whole Note 1 Prepare to write a Whole Note

Half Note 2 Prepare to write a Half Note

Quarter Note 4 Prepare to write a Quarter Note

8th Note 8 Prepare to write an 8th Note

16th Note 6 Prepare to write a 16th Note

32nd Note 3 Prepare to write a 32nd Note

Trill 5
Prepare to write a new Trill,  

or add a Trill to an existing note

Pralltriller 7
Prepare to write a new Pralltriller, 

or add a Pralltriller to an existing note

Mordent 9
Prepare to write a new Mordent, 

or add a Mordent to an existing note

Turn 0
Prepare to write a new Turn, 

or add a Turn to an existing note

MIDI Event M Prepare to write a MIDI Event

Exit X Exit Write Mode and return to Edit Mode
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Editing While Remaining in Write Mode 
As you work in Write Mode, you may want to also do some editing as you go, such as drag-
repositioning notes, or dragging note durations, etc. The Cursor icon allows you to do this 
without the worry of accidentally writing new notes, and without the hassle of having to 
switch out of Write Mode back into Edit Mode. 

Writing Notes 
To write a note, simply select the desired duration, and then click in the Detail View where 
you want the note to be placed. The various note Durations, from Whole Note to 32nd Note, 
are calculated according to the meter at that point in the MIDI file. MIDI Tapper displays a 
graphic notation where the lengths of notes are proportional, so that for example a Half Note 
takes up half the horizontal space as a Whole Note. Keep this in mind as in some cases 
depending on the width of the Viewport, you may select note values which will be drawn 
partially beyond the current Detail View. Notes can be repositioned and durations changed 
after being written; however, be sure to switch to the Cursor icon (type C) before dragging. 

Writing MIDI Events 
When you have selected the MIDI Events item in the Write Mode toolbar, clicking with the 
Pencil Cursor anywhere in the Detail View opens a popup menu from which you can select 
Patch Change, Volume CC, or Panning CC events. Before adding an event, be sure first to 
select the desired Track and Channel for the event.
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Writing Ornaments 
MIDI Tapper has four built-in ornaments: Trills, Pralltrillers, Mordents, and 
Turns. These ornaments can be written alone, or added to existing notes. 
Each ornament consists of a group of note values related to the meter of 
the imported MIDI file. Trills consist of 7 notes (or you can choose an 
option to trill the entire length of an existing note), Pralltrillers and Turns 
each 3 notes, and Mordents 2 notes. The duration of the notes added by 
an ornament is selectable via a Right-Click popup menu. The selected 
duration applies to all ornaments. 

Trills, Pralltrillers, and Turns are written starting above the main note; only the Mordent 
starts on the main note. To add an ornament to an existing note, simply select the ornament 
tool and click an existing note, keeping in mind that that note serves as the main note for the 
ornament. 

While Mordents are short enough to be tapped without much difficulty, trills and turns present 
special challenges. These ornaments are often better performed separate from the main Tap 
Stream. The next chapter explains how this can be done in MIDI Tapper using Rubatos. 

Ornament Begins Notes Example Preview

Trill  Ÿ above the note
7 or full 
length of 

note

Pralltriller  m above the note 3

Mordent  M on the note 2

Turn  T above the note 3

Ornaments are written diatonically in the key suggested by the surrounding notes.
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9. Separating Hands — Rubatos 
MIDI Tapper provides Rubatos as a way to add more flexibility and natural expression to trills, 
turns, and other free ornaments or cross rhythms which may be difficult to perform, or may 
sound too “square”, in a single Tap Stream. 

For example, Bach’s Prelude in G Minor BWV 861 from the Well Tempered Clavier, Book 1 
begins with a trill in the right hand over constant sixteenth and eighth notes in the left hand. 

This music has been realised in a MIDI file as shown below when imported into MIDI Tapper. 

A Rubato is a sequence of notes assigned to its own Tap Stream, optionally looped, 
and played only with specific keys of the MIDI controller that you assign.
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In order to sound natural and musical, the notes of the trill occur slightly out of time or 
slightly unmetered, resulting in a complex tap stream, as can be seen in the close-up below. 

This complex Tap Stream presents obvious performance difficulties. The lower notes should be 
played in more-or-less steady rhythm, while the upper voice should be played in free rhythm, 
but trying to tap the given Stream results neither in steady lower voices, nor in a free upper 
voice. The solution is to assign the upper notes (the notes in the trill) to a Rubato, separating 
those notes from the Tap Stream. 

Creating a Rubato 
A Rubato is created as follows: 

1. Select the notes that you want to be able 
to play freely outside of the Tap Stream 

2. Choose the menu item Rubato > Set or 
type Command-R or Right-Click and select 
Rubato > Set Rubato. A dialog window 
then appears to define the Rubato. 

Assigning Input Keys 
The table in the Rubato window with the headings Key and Name is a list of MIDI keys on your 
MIDI input device which are assigned to the Rubato. Once assigned, tapping those keys in the 
list will not move the main Tap Stream forward. Instead, tapping those keys will move through 
the Rubato in a separate independent Tap Stream. 
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A default set of MIDI input keys is given: the middle octave of the keyboard from middle C, 
chromatically up to the B above it. To assign a different set of keys, click Clear List, and 
simply play the keys on the MIDI controller that you want to use to tap through the Rubato. 

Looping Notes 
The notes selected for the Rubato can be assigned to operate in a loop, so that once you 
reach the last selected note, the Rubato Tap Stream will start over at the first note of the 
Rubato. This is useful for trills. 

Displaying As Text 
The MIDI input keys assigned to tap through the Rubato can be displayed as a Text object to 
remind you which keys you have assigned to tap through the Rubato. 

After assigning input keys and selecting the other options, click OK to set the Rubato. 
 

Appearance of a Rubato 
A Rubato is distinguished visually in the Detail View 
in the following ways. 

1. The notes of the Rubato are drawn with 
rectangles having rounded corners. 

2. The Tap line at the start of a Rubato is green, 
and has a circle at the top rather than a 
triangle. 

3. The notes of the Rubato are illuminated with a 
transparent green oval drawn over each note, 
moving from one note to the next as you tap 
through the Rubato. 

At right is shown the opening trill from BWV 861 
prepared with a Rubato using default input keys, 
loop option, and reminder Text object. 

Tapping With Separate Hands Through a Rubato 
The first tap of a Rubato can include any number of notes outside of the Rubato in its Tap 
Group. Each subsequent tap using any of the input keys assigned to the Rubato plays back 
only the notes in the Rubato, and does not move the Main Tap Stream forward. Tapping any 
other MIDI input keys (any keys not assigned to the Rubato) moves the Main Tap Stream 
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forward, independent of the Rubato. Once the Main Tap Stream has surpassed the right end of 
the Rubato, the Rubato stops whether you have reached the end of it or not, and normal 
Tapping resumes. In other words, there are two separate and independent Tap Streams, with 
the Rubato Tap Stream determining the start of the separation, and the Main Tap Stream 
determining the end of the separation. 

After you have tapped through a given piece of music, annotated it and assigned Rubato 
passages as needed, you may want to rehearse any difficult passages. A special mode for this 
purpose is explained in the next chapter. 
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10. Rehearsal Mode 

A typical part of practicing music involves isolating difficult passages and playing through 
them many times, usually starting slowly and then increasing the tempo to performance level.  
When making recordings, sometimes it is also useful to record a passage many times in a row 
and then choose the best version to splice into the final recording (see Chapter 12). In MIDI 
Tapper, this kind of practice and recording technique can be done in Rehearsal Mode. 

Entering Rehearsal Mode 
To rehearse a short passage in which all the notes fit into the detail view, begin by selecting 
all the notes in the passage. The different ways to select notes are outlined in Chapter 7. 
Marquee selection is an intuitive method. After the notes are selected, choose the menu item 
Edit > Rehearse Selection, or Right-Click and choose Rehearse … Beware that when the 
Take toolbar button shows a number rather than a star (when a Take is selected rather than 
the source data), the Rehearse option will be listed under Source Data > Rehearse. 

 

For longer passages, when the music does not all fit into the Detail View, place markers at the 
start and end of the passage, and use Right-Click > Rehearse Within Markers.  
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Once Rehearse … or Rehearse Within Markers has been selected, the Rehearsal window will 
open, showing the passage along with a transport in the upper left and a clapboard icon for 
managing Rehearsal Takes. Measure information is also given at the lower left. 

Rehearsal Tapping 
Once in Rehearsal Mode, you can tap through the passage as many times as you like. When 
you reach the end of the passage, the Tap Pointer automatically loops back to the beginning 
of the passage, so that you don’t have to break your flow. 

The main toolbar becomes unavailable during rehearsal mode. If changes need to be 
made to MIDI input or output, they must be made outside of Rehearsal mode.
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Rehearsal Takes 
There are many reasons you may want to record many versions of the same passage. The 
passage may be particularly difficult, or you may be unsure what kind of performance 
interpretation you want, or you may have a clear vision for the passage and you want to be 
able to catch the most inspired version of that vision without having to stop and start, click 
transport buttons, and lose your flow during the process. That is what Rehearsal Takes are for. 

Recording Rehearsal Takes 
Click the Record button to record any number of Rehearsal Takes. When you reach the 
end of the passage, the Tap Pointer returns to the start of the passage, and a new 

Rehearsal Take begins recording, so you don’t have to break your flow. 

Reviewing Rehearsal Takes 
Once you have recorded Rehearsal Takes, you may want to listen 
to them all or individually to evaluate or compare them. The Play 
button provides a popup menu for this purpose. 
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Discarding Rehearsal Takes 
Recording many Rehearsal Takes is a way of working that leads to throwing many versions 
away. It is possible that through this process you approach your ideal performance, in which 
case you want to keep only the last of many Rehearsal Takes. Or, you may record many 
Rehearsal Takes, and then decide that none of them are worth keeping. In either case it 
would be tedious to have to manually delete every unwanted Rehearsal Take. The Rehearsal 
Takes Clapboard icon provides menus for these situations. You can easily discard all Rehearsal 
Takes, discard only one of them, or discard all but one of them. 
 

Exiting Rehearsal Mode 
The Rehearsal Window includes two buttons marked Cancel and OK. When using the mode for 
tapping practice only, it does not matter which of these buttons is clicked to exit; however, it 
is very important to note that clicking Cancel will discard all Rehearsal Takes, and clicking OK 
will pass all remaining Rehearsal Takes to the Main Window, so that you can splice those takes 
into your final recording if you want to. 

If you want to keep any Rehearsal Takes upon exiting, click OK. 
If you want to discard all Rehearsal Takes on exit, click Cancel.
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11. Working With Takes 
Anyone familiar with music or film recording understands the concept of the Take. A Take can 
be defined as a performance caught in one session or attempt, or a sequence recorded 
continuously at one time. More often than not, a Take will be only a part of a larger piece, 
although sometimes recordings are done in a single take. Unless you are someone who never 
makes mistakes, managing multiple takes will be a core aspect of the work you do when using 
MIDI Tapper to create recordings. 

Recording a Take 
To record a Take, simply place the Tap Pointer at the position where you want to 
begin recording, and click the Record button in the Toolbar. Recording does not begin 
immediately; it begins whenever you begin tapping. Recording will stop when you 

click the Record button a second time. 

Using the Click (Metronome) 
A Click is another name for a Metronome, a device used to designate the Tempo (speed) of a 
musical performance. To prepare yourself to perform at the right Tempo, click on the Click 
Toolbar icon and select Turn Metronome ON, and select from 1 to 4 measures Countoff. 

The Tempo value is set by default to the value found in the imported source MIDI file. If you 
want to set a different tempo, simply choose Tempo > Set Tempo, and move the slider to a 
different value. 
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Note that when using the Click/Metronome, you do not need to start recording precisely in 
time with the click; nor do you need to start performing after the click stops clicking. 
Recording still starts whenever you begin tapping, and ends when you click the Record button 
a second time. 

Playing Back a Take 
After a Take has been recorded, it is ready for playback. The Takes toolbar icon 
shows the number of takes which have been recorded. For example, the icon at left 
below is shown after one take has been recorded.  

When multiple takes have 
been recorded, you can select 
which take to work with, and 
the Takes icon will display the 

number of that Take. Simply click the 
Takes icon and select the Take you want 
to work with from the popup menu. For 
example, if three Takes have been 
recorded, but you choose Take 2, the 
icon will display a 2 and not a 3. 

When the source file is 
selected (the Tracks icon 
displays a star) clicking the 
Start button moves playback 

to the beginning of the file. When a Take is selected (the Tracks icon displays a number), 
clicking the Start button will cue playback to the start of the selected Take. 

The Tempo of Take playback can be changed under the Click menu. 

During playback, the display shows the music which is currently playing, changing its contents 
when playback moves forward past what is currently displayed. 

Conductor Playback 
When recording a Take, two data streams are recorded: one which contains MIDI 
data, and one which contains tapping actions. This latter data stream is called a 
Conductor track. When you click the Conductor toolbar button, a menu allows 
you to select any recorded Take for playback using the Conductor track, which 

taps through the music just as you did.  
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The usefulness of this may not be immediately obvious. The difference between the recorded 
Take and the Conductor track of that take is this: the conductor track taps through the MIDI 
data currently displayed on the screen, it doesn’t play back the MIDI data that was recorded. 
This means that you can edit the data after recording, and tap through it again using the 
Conductor. You can also record the conductor output as a new take. 

Retaking (Replacing) a Take 
Sometimes you may have trouble performing a passage the way you want. Although using 
Rehearsal Mode will usually be a better way to get the results you are after (see Chapter 
10), in cases where rehearsal isn’t necessary, you can simply retake the take. Click the Takes 
button in the Toolbar and select Retake. Because the action will replace the take, a 
confirmation window appears, but you can bypass that window by holding the Command key 
when selecting Retake. The Tap Pointer will return to the place where the Take began, and 
the Take will be replaced. 

Duplicating a Take 
After recording a Take, you may want to Modify it (see Chapter 13), edit its MIDI events (see 
Chapter 15), or perform Velocity Shaping (see Chapter 14) — without worrying about having to 
undo your actions. In that case it is a good idea to duplicate the Take before making any 
modifications or edits. Simply click the Takes button in the Toolbar and select Duplicate. 

Copying a Take 
This option is available for cases where you have two or more projects open and you want to 
Copy/Paste a Take from one project into another. Click the Takes button in the Toolbar and 
select Copy. Then switch to the other project, click on its Takes toolbar button and select 
Paste. Keep in mind that pasting a Take into a project that does not contain the source MIDI 
file from which the Take was made is possible but will result in odd behaviour, because MIDI 
Tapper correlates recorded Take data to the data in the imported source file. 

Renaming a Take 
MIDI Tapper automatically names Takes simply with the word Take followed by a number: Take 
1, Take 2, etc. For projects with only a few Takes, this may suffice, but for large projects you 
may want to give Takes more meaningful names to optimise your workflow. To do this, click 
the Takes button in the Toolbar and select Rename. An input window appears so that you can 
type in a new name for the Take. 

The Conductor plays back Taps, not MIDI data, and you can 
record the conducted playback as a new Take if you want to.
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Deleting a Take 
To delete a Take, click the Takes button in the Toolbar and select 
Delete. Because the action cannot be undone, a confirmation 
window appears, which you can bypass by holding the Command 
key when selecting Delete. 

Opening a Take in a New Window 
Although MIDI Tapper allows you to edit Take data in the Detail View by selecting notes and 
choosing Right-Click > Current Take …, the data displayed in the view is always from the 
source file and not the Take (see Chapter 8), which may in some cases may not be the 
situation that you are looking for. To see and work with the Take data graphically exactly as 
you recorded it, the data must be exported as a MIDI file and imported as a source file into in 
a new MIDI Tapper project. Clicking on the Takes button in the Toolbar and selecting Open in 
New Window does just that, without requiring you to go through the steps of exporting and 
importing the file. 

Exporting a Take 
You may export any Take as a Type 1 .mid file for use with any software that supports 
the .mid format. Click the Takes button in the Toolbar and select Export. A dialog appears 
allowing you to name the file and save it. 

Reviewing Takes 
It may be useful to listen to and compare takes in graphical overview, length, number of 

measures spanned, and so on. The Takes Window is available for that purpose. 
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Transport icons in the Takes Window function as expected. Click the Gearwheel icon to open a 
popup menu with many of the options explained in this chapter and the next. 

After you have recorded your takes, several post-production methods are available to allow 
you to tweak your performances, consisting of: 

1. Splicing takes together 
2. Modifying articulation of independent voices in tapped performances 
3. Shaping overall velocity histograms to naturally scale dynamics 
4. Editing MIDI data directly using a MIDI Events List 

These topics are covered in the next four chapters. 
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12. Splicing Takes Together 

Although a musical performance recorded in a single Take may represent an ideal, since the 
invention of magnetic tape it has been normal practice to combine several Takes together to 
eliminate flaws or capture more inspired moments. A Splice refers to the joining together of 
two Takes, and the process of putting Takes together is called Splicing. MIDI Tapper lets you 
splice Takes together in two ways: the Simple Splice, and the Insert Splice, as explained 
below.

 

The Splicing Process 
The process of splicing involves first imagining a resulting flow of music in terms of one Take 
moving into another. In the Splice Window, this flow is organised from left to right, and 
instructions are given at the bottom of the window at each step of the process. You choose a 
Left Take, and a Right Take, to splice together with a Simple Splice or Insert Splice. Each side 
includes an Overview and Viewport for navigation, and transport buttons to preview each 
Take. A note must be chosen in each Take, marking a splice point. These notes become 
outlined and are marked with “CUT”, and “Continue …” according to the direction of flow. 
For a Simple Splice, there is one note to select in both Left and Right Takes. For an Insert 
Splice, there are two notes to choose, as the Left Take begins flow, the Right Take picks up 
the flow, and hands the flow back to the Left. After these notes have been chosen, the Splice 
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is made, and a preview of the result is given, to be approved or rejected. If rejected, the 
process is cancelled and the window returns to its initial state. If approved, a name is given 
to the result, and the Takes used to make the result can be deleted at that point if desired. 

Simple Splice 
A simple splice consists of two Takes joined together at a single Splice Point. The Left Take is 
spliced to the Right Take as in the diagram below. Example: 

•Left Take: starts at the beginning and is flawless 
up to a point where a mistake is made. 

•Right Take: has been recorded starting just 
prior to the mistake, continuing without error to 
the end.  

For a Simple Splice, one note is selected on both Takes: a note in the Left Take where the 
Splice is to occur, marked “CUT”, and a note in the Right Take where it is to be spliced into 
the first, marked “Continue …”. The same note must exist in both takes, and must be first 
selected on the left, then on the right. When you select the note on the left, MIDI Tapper will 
try to find the corresponding note on the right for you, but you may have to find it yourself.
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Insert Splice 
When a portion of one Take is inserted into another Take, it is called an Insert Splice. The 
Right Take is inserted into the Left Take as shown in the diagram below. 

Example: 

• Left Take: is the way you want it, except for a mistake in one spot. 

• Right Take: is an error-free recording beginning shortly before and ending 
shortly after the mistake in the Left Take. 

For an Insert Splice, check the Insert option. Two notes must then be selected in 
both Takes: a note in the Left Take where the Splice is to occur, marked “CUT”, 

a note in the Right Take where it is to be spliced into the first, marked “Continue …”, a 
second note in the Right Take where the inserted passage is to end, also marked “CUT”, and 
a second note in the Left Take where the insertion ends and the left Take picks up again, 
marked “Continue …”. Each time you click on a note, MIDI Tapper tries to find the 
corresponding note in the opposite view for you, but you may have to find notes yourself.
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Approving / Rejecting a Splice 
After clicking the Splice or Insert button, the result is presented for approval or rejection. 
The Tap Pointer is placed shortly before the splice point, and a transport allows you to play 
back the result.

 
 

If the Reject button is clicked, the process is cancelled and the Splice Window 
returns to its initial state. 

If the Approve button is clicked, a textfield appears to name the resulting 
spliced Take, with an option to delete the source Takes. By default, the name of 

the spliced take consists of the names of the Takes involved in left-right order. If the Splice is 
of the Insert variety, the name begins with the word “Inserted”. 

Clicking the Continue button finalises the process and returns to the initial state of the Splice 
window, including the newly spliced take in the Take selection popup menus. 
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13. Modifying Articulations 

MIDI Tapper allows you to modify the articulation of any notes in a recorded Take, by selecting 
notes and tapping through them independently, to achieve a more natural sounding result. 

Tapping vs. Multi-Pass Recording 
In multi-pass recording, each part is recorded individually, and the resulting combination of 
passes is then possibly quantised, often using a humanisation algorithm to keep the result 
from sounding too mechanical. MIDI Tapper’s Tap Group paradigm obviates the need for multi-
pass recording, and humanisation algorithms are not needed because the performance is 
already human. A single tapped performance is thus coherent and authentic in a way that 
multi-pass recordings cannot be, because a single intention is captured in real time instead of 
many, with the timing of all events controlled by a single performance with no quantisation or 
algorithmic manipulation. As a recording concept, tapping thus comes much closer to the 
ideal of conventional performance than multi-pass recording. 

Why Modify Notes? 
An important consequence of the Tapping paradigm is that notes are articulated together in 
Groups, and this fact represents a possible downside when compared with multi-pass 
recording. In cases where the music is relatively homophonic, tapping can produce a natural-
sounding result without further modification, but in cases such as polyphonic music where 
voices would normally be articulated independently, a tapped performance can sound a bit 
unnatural. Musicians articulate notes in any number of ways throughout a performance, and 
the expressive ways in which notes are articulated form an integral part of an overall 
performance. Modifying a Take with individual articulations is thus a musically important way 
to improve the expressiveness of a tapped performance.  

What Is Modified? 
In terms of note parameters recorded by MIDI Tapper, articulation primarily involves note 
Velocity and note Duration. MIDI Tapper thus allows modification of Velocity and Duration of 
any selected notes in a recorded Take. This is done without changing the recorded Note ON 
times, so that the articulation can be performed naturally without having to worry about 
synchronising the rhythm (the Note ON times) exactly with what has been recorded. In other 
words, when modifying note Durations, one needs to be rhythmically precise with note 
releases, but note attacks do not need to be in strict time, because they are already given in 
the recorded Take. Although articulation can also be said to involve note onset (MIDI Note ON) 
timing, that aspect of performance is better considered part of the Tapping paradigm. 
Nevertheless, Note ON times may also be modified after a Take has been recorded. 
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Selecting Notes for Modification 
Keep in mind that you must only select notes that actually exist in the Take being modified, 
or modification will not work. 
  

Velocity & Duration Options 
Once the notes are selected, click the Modify toolbar 
button and select the option listing the parameters 
you want to modify if it is not already selected. 

Because you will usually want to modify note Velocities & 
Durations, that option defaults as selected. 

Note ON Time Options 
Because modifying Note ON Times is less likely to be needed, that option is separated and 
pushed to the bottom of the menu. Selecting + Note ON Times means whatever combination 
of Velocities and Durations you have selected will be combined with the Note ON Times 
option. Selecting Note ON Times Only means Velocity and Duration will not be modified. Keep 
in mind that modifying Note ON Times requires you to match your performance tempo and 
rhythm to the recorded Take exactly or the result will sound wrong. Therefore it should be 
used with caution. A reasonable guideline is as follows: 

Modifying Selected Notes 
After selecting the notes to modify and choosing the modification options you want, 
click the Modify toolbar button and choose Modify Selected Notes from the menu. 
The Modify button will appear illuminated, and the Tap Pointer will move to the first 

note in your selection. Tap through the notes with the articulations as you want them. When 
you reach the end of the selection, the process ends automatically and the Modify button 
returns to its off state. The Tap Pointer also moves to a position slightly before the modified 
notes, so that you can click Play to preview the result. If you are not happy with your 
modification, you can Undo the action. 

Modifying and Workflow 
In order to understand how Modify functions can be useful for your work, it may be helpful to 
keep in mind the following general workflow model of four stages (compare with the 
Introductory workflow list given on pages 10 and 11):  

Use the Note ON Times modification options sparingly, and limit 
your selections involving these options to a few notes at a time.
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1. Import the MIDI file and prepare it for tapping by Grouping and 
Ungrouping Taps as needed, adding Markers and Texts, assigning Rubatos, 
adding Ornaments*, and so on. 

2. Tap through the piece as a whole, recording one or more Takes. Often 
arriving at your goal will require splicing several Takes together. The 
result should be a Final Take which is free of errors.  

3. Shape the details of your expression by Modifying articulations the Final 
Take to musically clarify various voices as would be done in a 
conventional performance. 

4. Reshape Velocities and edit MIDI Events in the Final Modified Take to 
tailor the MIDI output for final rendering. 

* Adding ornaments is a function available in Write Mode, explained in Chapter 8.  

The last stage listed above involves the topics of the next two Chapters. 
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14. Velocity Shaping 

MIDI Tapper can analyse all the velocity values (dynamics) performed in a selection per track, 
so that you can see the relative dynamics of passages — how loud or soft you are playing in 
terms of MIDI velocities. You can then shape the high, low, and peak values per track or as an 
average of all tracks, in order to sharpen the dynamic consistency of your performances. 

Editing vs. Reshaping Velocities 
There are many ways to edit recorded Take velocity values, as discussed in Chapter 8. For 
example, after selecting notes, try Right-Click > Current Take > Set Value,  Add Value, 
Subtract Value, or Scale Values. All of these functions can be applied to a range of MIDI 
parameters (note, duration, Note ON time, velocity). This chapter deals with a special kind of 
editing devoted to Velocity data, called Reshaping. Two options shown at the bottom of the 
Right-Click menu, Reshape Velocities and Balance Tracks Velocities, are discussed below. 

Why Shape Velocities? 
Musicians practice music with aims for general dynamic levels, but when the moment comes 
to perform the music for a recording under pressure, the music can be performed dynamically 
differently than prepared. While sometimes that can be okay, usually it means that the 
recording does not sound as intended. Sometimes it also takes more than a single session to 
record a piece, by splicing multiple Takes together, and from one session to the next 
performance dynamics can change, so that splicing Takes together results in noticeable shifts 
in dynamic levels. Whereas in conventional performance it is impossible to change the 
performance dynamics of the music after it has been recorded, MIDI Tapper allows you to do 
just that. Changing velocity values relatively, increasing or decreasing them at once or over 
time, is useful for improving small sections of music, but it also requires a lot of disjointed 
work, raising values or lowering them, in curves or lines. Velocity Shaping is an option which 
works on the data holistically, allowing you to reshape your recordings while preserving the 
underlying integrity of your performance. Reshaping is intended to save you time and trouble 
involved with conventional piecemeal editing techniques, so that you end up with a more 
natural, coherent result. 
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Selecting Notes for Velocity Shaping 
Shaping velocities begins by selecting notes. The different ways to select notes are outlined in 
Chapter 7. Because the shaping of dynamics tends to be a composition-wide or section-
oriented musical parameter, using Select All or adding Markers and using the Select Within 
Markers options are helpful. For example, if you have spliced together two Takes, and upon 
previewing the result you realise that the second Take has been performed at a slightly 
different dynamic level than the first, you can add a marker at the splice point, and then use 
Select Within Markers to select the spliced portion from the second Take in order to reshape 
velocities to better match the first Take. 

The Velocity Shaping Window 
After selecting notes and choosing Reshape Velocities, a window opens showing a chart of all 
the velocity values in the selection, grouped and color-coded by Track. The chart is a 
histogram, which is just a fancy word for a bar graph, showing all MIDI values from 0 to 127 
on the x axis. Normally, the data will vaguely resemble a bell curve. 

The Tracks menu allows you to select All (default), or individual Tracks.  
 

Initially, raw data is displayed and no numbers are visible in the fields marked 
High, Peak, and Low Value. Click the Average button to see values and 
enable the sliders.  
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Click Revert if you want to see the raw values again.  

The vertical slider on the right controls the Offset value. When you move this slider, 
all three values — High, Peak, and Low — are moved together as a unit, up or down. 
The relationships between the values remain the same. You might think of this as a 
sort of master volume fader for all of the dynamics in the selection. 
 

Adjusting the High value moves the highest value in the chart higher or lower (right or left). 
As you adjust this value, you will notice that the values in between the Peak and the High 
value will be adjusted proportionally. The result of this will be an overall increase or decrease 
in the velocity values and range of the loudest dynamics in the selection. 

Adjusting the Peak value alters the highpoint of the curve. The result of this will be an 
overall increase or decrease of the majority dynamic level in the selection. 

Adjusting the Low value moves the lowest value in the chart higher or lower (right or left). As 
you adjust this value, you will notice that the values in between the Peak and the Low value 
will be adjusted proportionally. The result of this will be an overall increase or decrease in 
the velocity values and range of the lowest dynamics in the selection. 

After you have moved all the sliders where you want them, click OK and the velocities will be 
reshaped. If you are not happy with the result, you can Undo the operation. 

Balance Tracks Velocities 
Sometimes after recording Tracks, Splicing them together, Modifying articulations, and so on, 
the relative velocities of various voices can become unbalanced. Or there may just be a 
passage in which one voice is louder than the rest, or softer than the rest, and you want to 
somehow get a less stratified result without having to directly edit the voice that is at an 
unwanted dynamic level. The menu item Right-Click > Balance Tracks Velocities is available 
for these situations. MIDI Tapper will analyse the total velocity content of the selection, and 
alter the relative velocities of the voices to produce a smoother result. If you are not satisfied 
with the result, you can Undo the operation. 
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Viewing Average Velocities 
When working with the Velocity Shaping Window, you may sometimes want to have in mind 
data values from other sections of the piece, or from the piece as a whole. Or you may want 
to know those values as you are editing MIDI data in other various ways. Two Right-Click 
menu options are available under View Average Velocities for that purpose. 

When you select All or Within Markers, a simplified version of the velocity shaping window 
appears, showing the length of the section in measure numbers, and the Low, High, and Peak 
values within the selection. A white box is also drawn in the overview to show the portion of 
the piece analysed. The simplified window does not allow you to edit the values; its purpose 
is only to inform. Once you have understood the data, click Done to close the window.

 
The next chapter discusses other ways to edit velocities and other MIDI data. 
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15. Editing MIDI Events 

MIDI Tapper allows MIDI data to be edited in both conventional and novel ways. This chapter 
explains how MIDI data is handled by MIDI Tapper, and introduces you to the methods and 
functions available for MIDI data editing. 

Source Data vs. Current Take data 
Source Data refers to the imported MIDI file data, and Current Take data refers to recorded 
performance data: specifically, the Take currently selected in the toolbar. It is essential to be 
aware of the difference between these two sets of data when editing MIDI data in MIDI 
Tapper. The Source Data is always that data which is displayed graphically in the Overview 
and Detail View. It may help to think of this as the musical score, as graphical musical 
notation, from which your performances are derived. The performance timings, durations, 
articulations, and so forth in the Current Take data are not shown in the graphical display 
(because they are not part of the Source Data). When a Take is selected for playback in the 
toolbar, what you see is still the Source Data, what you hear is the Current Take data.

 

Linked Takes 
Source Data and Current Take data are different and separate data sets, but when you select 
a note in a recorded Take, that note can be located in the Source Data, and vice versa. This is 
done using Track and Note Indexing. Each note in the Source Data has a Track index, and a 
Note index within each Track. For example, the first note in Track 1 has a Track index of 1 and 
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a Note index of 0. Through this system of indexes, each Take is said to be Linked to its Source 
Data. By definition every Take thus begins its life as a Linked Take. 

Post-Take Source Data Editing 
If Source Data is edited after a recording has been made, MIDI Tapper attempts to update all 
Linked Takes with the changes made to the Source Data. For example, if the vertical position 
(Pitch, MIDI note number) of a note is changed in the Source Data, that note will be found and 
updated in all Linked Takes. This kind of editing should be done carefully, because some 
actions could possibly result in broken Links, such that the notes in the Linked Takes can no 
longer be found in the Source Data, and vice versa. For lack of a better term, such a Take is 
called a Broken-Link Take. The practical consequences of a Broken-Link Take should be 
considered before you decide to Post-Take edit your Source Data. For a Broken-Link Take: 

1. MIDI playback will function normally, but the display will not update 
properly during playback.  

2. Display of Track and Note Indexes in a MIDI Events List will show incorrect 
information in the Track and Note columns. 

3. Selecting Notes in a MIDI Events List will not select the correct notes in 
the Detail View. 

4. Editing MIDI data using a MIDI Events List will be incorrect and 
unpredictable. 

Current Take Editing 
Although some caution must be taken when editing Source Data Post-Take, as a normal post-
production stage of MIDI recording — your opportunity to perfect the MIDI output of your 
performance, editing the MIDI data of a recorded Take presents no risks. MIDI Tapper provides 
two editing workflow methods: Detail View Right-Click, and opening a MIDI Events List. 

Detail View Right-Click 
Working in the Detail View with Right-Click popup menu items is the most direct way to edit 
MIDI data in MIDI Tapper. The menu items are created dynamically according to the Current 
Take, and whether notes are selected or not. When no notes are selected, the popup menu 
contains fewer options. With notes selected, the menu shows many more options, some of 
which are included only when relevant to the properties of the selected notes. The possible 

MIDI Tapper updates Linked Takes with edits made to 
Source Data, but one must take great care when doing 

this kind of editing, as it can result in Broken-Link Takes.
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menu options are discussed below under individual option headings starting with Popup Menu 
Editing Options. 

MIDI Events List 
In contrast to the the Detail View, which always shows the Source Data, the MIDI Events List 
can show recorded MIDI events for any Take (including the Source Data). Additionally, when 
showing the data belonging to a recorded Take, all messages can be edited in all parameters: 
Time, Status, Data, as well as Track and Note linking info (see above).

 
* Note that when Source Data is shown, the data is not editable in the MIDI Events List. 

** Editing event data bytes should only be done if you understand MIDI messages 
 

The leftmost button at the top of the MIDI Events List Window allows insertion of MIDI 
Sustain Pedal ON / OFF events. This is a convenience for dealing with these messages 

specifically, because they are so important for piano music (for which MIDI Tapper is 
optimised). In situations where you have no sustain pedal and are unable to record sustain 
events as part of your tapped performance, this button allows you to add those messages 
manually. 
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The button on the top right provides access to all of the common editing Popup Menu 
Editing Options which are also available through Right-Click in the Detail View. 

Adding or Removing MIDI Events 
 These buttons give you a convenient way to add or remove MIDI CC events. You may 

change the type of MIDI Event to anything you want, but keep in mind that it can be risky to 
add or remove note-related MIDI events from the MIDI Events List, because of data Linking, as 
described above. 

Absolute Event Times 
Although MIDI files operate with delta times, the leftmost column of the list shows the 
absolute times of all MIDI events, in milliseconds. This approach allows you to see 
relationships between events as you scroll through the list, whereas showing delta times 
would provide no such information. 

Editing Listed Values 
The Time, Data, Track, and Note columns are all edited in the same way, by clicking the 
grey triangle and typing in a value or values into a subsequently appearing dialog entry 

field. Editing a Data value is shown below. Note that the value is a comma-separated list.
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Editing a MIDI event Status does not open a dialog, but instead opens a popup menu listing all 
the available MIDI Status messages. 

Popup Menu Editing Options 
The editing options which are common to both the Detail 
View Right-Click and the MIDI Events List are contained in 
a popup menu which also includes the Velocity Shaping 
options discussed in the previous chapter and one other 
general option discussed below. In general, the editing 
functions deal with MIDI values, allowing you to Set, Add, 
Subtract, or Scale those values.  

Parameter Values 
For each function, a submenu is available to allow selection of Time, Note, Velocity, or 
Duration. It is helpful to keep in mind the following properties of each parameter. 

Parameter Determines Range Units

Time event time 0 - ? milliseconds

Note pitch-height 0 - 127 MIDI

Velocity note loudness 0 - 127 MIDI

Duration note length 1 - ? milliseconds
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Fix Note On/Off Conflicts 
Repeated notes in a MIDI data stream can sometimes result in a problem which is easy to hear 
but difficult to see, or which is easy to grasp mentally but difficult to describe or show 
graphically. It happens when two of the same notes in the same voice are overlapping, and 
the Note OFF event from the first note comes after the Note ON event of the second note. 
The result is that the second note gets “choked” so that it doesn’t sound, or only sounds for a 
few milliseconds. In MIDI Tapper, this situation is called a Note On/Off Conflict, and this menu 
item exists to fix the problem. In general, you should not need to use this function very often. 

Set, Add, or Subtract Value 
For all notes in a selection, a fixed value can be set for the Time, Note, Velocity, or 
Duration. A fixed amount can also be added or subtracted from any one of those parameters. 

Scale Values > Flat 
The Scale Values > Flat option is useful for situations where it is useful to think about 
changing values in terms of a percentage. Under this option, the Note parameter is not listed. 
For example, it may be easier to imagine the velocities of all the notes in a passage at 120% 
of their current value rather than adding or subtracting some fixed amount to existing values.  

When working with Time, it is important to remember that more or less than 100% means 
more ore less Time, so a larger percentage is not faster; it is more time, so it is slower. MIDI 
Tapper handles the shifting of surrounding events for you. For example, if you chose to 
change the Time parameter of a selection to 200%, then all the events in the passage will 
happen twice as slowly. 

Usually you will want to edit the timing of Note ON and Note OFF events together, but there 
may be cases where you want to deal with ON and OFF events separately. Keep in mind that it 
is only possible to do that in the MIDI Events List. 

Time: < 100% Time: 100% Time: > 100%

less Time current Time more Time

faster current speed slower
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Scale Values > Linear 
The Scale Values > Linear option is a 
percentage model for changing values over 
time. Two values are input into the entry 
field separated by a colon. 

Effectively this tool allows the manufacture of conventional tempo changes (accelerando and 
ritardando) and dynamic changes (crescendo and diminuendo). It is important to remember 
how MIDI Tapper handles the Time parameter, as it is easy to accidentally reverse the logic 
when inputting your values.  

Under the Scale Values > Duration menu, there is no Linear option, because it does not 
correspond to a normal musical function. 

Scale Values > Velocity > Slider 
An additional option is provided for scaling Velocity values using a slider. When you select this 
option, a slider appears on screen in the Detail View, which looks and behaves the same as 
the slider that appears when you select Edit Note Params > Velocity. All values are 
proportionally scaled by the MIDI value shown, which is the highest Velocity value in the 
selection. 

Alter Timing 
Sometimes you may find that the timing of your tapped performance could be improved by 
removing or inserting just a few tens of milliseconds in between selected taps. MIDI Tapper 
provides an easy way to do this, without having to select large numbers of events. Simply 
place the Tap Pointer at the point where you need to add or remove time, and then Right-
Click and choose Alter Timing > Insert Time or Remove Time and Before Tap or After Tap. 

Scale Values > Linear > function musical term

Time: 100% : lower value speed up accelerando

Time: 100% : higher value slow down ritardando

Velocity: 100% : higher value get louder crescendo

Velocity: 100% : lower value get softer diminuendo
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A dialog opens with an entry field for inputting a value in milliseconds to insert or remove. 

The specified number of milliseconds is then added or removed from before or after the Tap 
Pointer as selected. It is important to remember that the time is inserted or removed relative 
to the Tap Pointer, not at the location when you have right-clicked. 

To fix timing issues, place the Tap Pointer nearest the location where you want to insert 
or remove time, select Before Tap or After Tap, and enter a value in milliseconds.
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16. Analysis 

MIDI Tapper is capable of analysing tonal four-part harmony, using a library of 
sonorities derived from nearly 400 four-part (SATB) chorales written by Johann 
Sebastian Bach (1685-1750).  

 

Four Voice Harmonic Analysis 
Composition in four parts (SATB) forms the basis of instruction in harmony throughout the 
Western world, and the chorales of J.S. Bach serve as the model of perfection of this 
technique. The analysis engine in MIDI Tapper is based solely on Bach’s 4-part chorales, 
wherein every vertical sonority is analysed as a triad with possible extensions, suspensions or 
added dissonances, or omissions. When dissonances are present, they are considered to be 
integral members of the sonority. This approach differs from that often used to analyse 4-part 
chorales, where dissonances are separated from triads into various types of Non-Chord-Tones 
(NCTs). Including dissonances as chord members allows unique labels to be given to all unique 
sonorities, and is also an important concept for developing one’s harmonic vocabulary. 

Chord Symbols 
MIDI Tapper focuses on identifying vertical sonorities with Chord 
Symbols, to display maximum information in a single label. A simple 
common Chord Symbol shows a Root and Quality, such as the Chord 
Symbol for a root-position G Minor triad, shown at right. 

A Chord Symbol in its most elaborate form 
can show a Root, Quality, Extensions, 
Suspended or Added dissonances, Omissions, 
and a slash followed by a Bass Note when it 
differs from the Root Note. A diagram of such 
a Chord Symbol is shown at right. 
Although Chord Symbols are normally used in 
the composition and analysis of modern jazz, the rich diversity of sonorities used in Bach 
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Chorales has only loose connections to jazz. The logic used for naming Chord Symbols in the 
MIDI Tapper library is thus not based on a jazz paradigm, but rather directly reflects the 
aesthetic of Bach's chorales, with particular care given to the manner in which dissonances 
were treated by Bach. 

Suspended vs. Added Dissonances 
When deciphering a Chord Symbol, it is important to understand the difference between a 
suspended dissonance, which is indicated in a Chord Symbol by sus, and an added dissonance, 
indicated by add. Luckily, the difference is simple. Any dissonance which takes the place of 
the 3rd in a chord is labeled sus. If the dissonant note is present in addition to the third of a 
chord, it is labeled add. 

Any note labeled sus in a Chord Symbol may or may not be an actual suspension in terms of 
the strict use of that term in part-writing analysis. 

Dissonances in the Bass 
When a dissonant note appears in the bass, analysis using Chord Symbols and Roman Numerals 
can become somewhat confusing. To clarify matters, whenever a dissonant note is in the bass, 
MIDI Tapper Chord Symbols show include the word (bass) in parentheses next to the listed 
dissonant note in the Chord Symbol. 

  

Key Signature Events in MIDI Files 
MIDI data in general does not contain note-name information (a C-Sharp and an D-Flat are 
both represented by the same data), so although it is not difficult to identify a Major triad in 
a MIDI file, it is not possible to differentiate between a C-Sharp Major triad and a D-Flat Major 
triad. Key Signatures can help to solve this problem. MIDI files can contain Key Signature 
events, but unfortunately many files either do not contain this information, or contain wrong 
information. When a Key Signature event is included but indicates a wrong key, MIDI Tapper 
allows the existing event to be edited, either in the Detail View or in the MIDI Events Window. 

Label Dissonance

sus replaces the third of a chord

add the third of the chord remains
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Dorian Key Signatures 
In music of the baroque era such as the music of J.S. Bach, Key Signatures for Minor flat keys 
sometimes follow a “Dorian” convention (as a holdover from modal practice), omitting one 
flat in the Key Signature. For example, D Minor may be written with no flats instead of one, 
or C Minor may be written with two flats instead of three. Since changing a Key Signature in a 
MIDI file might be seen as an unwanted altering the composer’s original score, MIDI Tapper 
includes an Analysis option to instead analyse the file according to a Dorian Key Signature. 
Selection of a Dorian Key Signature for analysis is left up to the user.  

Roman Numerals 
Roman Numeral analysis in MIDI Tapper is based on present day standard music 
theory derived primarily from the work of Jean-Philippe Rameau (1683-1754), in 

which Roman Numerals representing diatonic scale degrees and triad qualities are combined 
with Figured Bass symbols commonly referred to as inversions, extensions, and alterations. 

Accurate functional harmonic analysis using Roman Numerals requires identification of local 
key centers and modulation. Because MIDI files provide very little context for the spelling of 
notes, and no cues at all concerning modulation, MIDI Tapper does not implement a complete 
system of functional Roman Numeral analysis. Roman Numeral functional identification is 
limited to the following cases.  

1. Diatonic triads and 7th chords in the Key designated by the MIDI File 
2. Secondary Dominants & Leading Tone chords for diatonic chords which 

may normally be assigned temporary tonic function 
3. Augmented Sixth Chords in any key area (conventional inversions only) 

Roman Numeral analysis without context for modulation often results in an empty result, so 
that even when Roman Numeral Analysis is selected, results may be lacking for many 
sonorities. Results that are given also may sometimes appear questionable, due to lack of 
key-center context. To avoid such results, this feature may simply be deactivated. 

Unknown Sonorities 
In any case where a sonority is unknown, note names may optionally be listed. Octave 
numbers are included with letter names, according to the North American system where 
middle C is called C4. Any 4-voice (or fewer) sonority which does not appear in Bach’s 
chorales will not be identified by MIDI Tapper. Any chord consisting of more than four unique 
pitches also will not be identified, even though some of these sonorities are very similar to 
those that MIDI Tapper understands. 
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Voice Crossings 
 Voice crossings are found by comparing pitches on neighbouring 

MIDI Tracks and Channels. For example, if Track 2 contains an Alto voice, and Track 3 contains 
a Tenor voice, and a note on Track 3 is higher than a note on Track 2 in a given sonority, then 
that sonority is marked as containing a voice crossing per Tracks 2 & 3. The same logic is 
applied to channels which cross, either on separate tracks, or on the same track. Obviously, 
MIDI files must be prepared with this function in mind in order for these results to be 
meaningful. 

Analysis Manifest 
A summary of MIDI Tapper’s analysis of a given file is viewable as a text output list via the 
menu item Window > Analysis Manifest. The Manifest includes the number of unique 
sonorities, chord types, qualities, and voicings. The table below clarifies what is meant by 
each of these terms. 

sonority any vertical combination of pitches (including repetitions)

voicing a unique sonority, considering all pitch placements

type the general form of a sonority, disregarding pitch placement above the bass

quality the general form of a sonority, disregarding all pitch placement
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17. Hauptwerk Features 

Hauptwerk is software for playing sampled pipe organs via MIDI. MIDI Tapper provides many 
special features for Hauptwerk users for creating convincing performances of music for organ, 
including importing stop lists for various organs, automated assignment of voices to the 
divisions of the organ, and inserting registration changes into the tap stream. It is assumed 
that the user has the latest version of Hauptwerk, which at the time of this writing is 
Hauptwerk 4. Earlier versions of Hauptwerk have not been tested with MIDI Tapper. 

Enabling Hauptwerk Features 
Because not all MIDI Tapper users need these functions, Hauptwerk users must first open the 
Preferences Window under Tapping, and check Enable Hauptwerk Features. After 
Hauptwerk features have been enabled, additional menu items are available. 

 

Preparing the MIDI Port in Hauptwerk 
To receive notes and registration changes from MIDI Tapper, Hauptwerk must have a MIDI IN 
port set to “Sequencer MIDI In (advanced usage)”. This is done in under the main menu item 
General Settings > MIDI Ports … In Hauptwerk version 4, this is a column heading. 
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In Hauptwerk version 5 and above, it is a row heading on the left, with text which is also a bit 
difficult to read. In each case, you need to select a MIDI input port by checking a checkbox.  

This port must also be selected as the MIDI Output port (called the MIDI Output Destination) 
in MIDI Tapper. Click on the MIDI toolbar icon or select the menu item MIDI > Input / Output 
to set the output port to the one you have assigned to sequencer input in Hauptwerk. 

Importing Stoplists 
To support organ registrations, MIDI Tapper needs a list of stops for each organ. Hauptwerk 
supplies this information in the form of an .xml file only when you open the menu item 
Recording > View Hauptwerk MIDI recorder/player fixed, predefined MIDI implementation 
(for this organ)… An .xml file is then generated which can be imported into MIDI Tapper. The 
location of the file varies with different versions of Hauptwerk, as explained below. 

Note that Hauptwerk will only do this when you select the menu item, and Hauptwerk will 
also delete this file when you restart Hauptwerk, so when you do this, it is a good idea to 
drag the file out of the generated location and put it somewhere else so that you won’t need 
to generated it again.  

Once you have the .xml file, in MIDI Tapper, go to the menu item File > Import Hauptwerk 
Stoplist and navigate to the stoplist xml file for the organ you want to work with. Once the 
xml file is loaded, Hauptwerk registration changes for that organ can be inserted into the tap 
stream. If you find that there is no file for the organ, contact the maker of the sample set 
and ask them to provide a MIDI Recorder MIDI Implementation.xml file. For for information on 
the xml files, please see the documentation for Hauptwerk. 

Hauptwerk instrument stoplist files begin with the name of the organ, end with  
“MIDI Recorder MIDI Implementation.xml” and are generated by Hauptwerk in the 

following directory: 
  

v4: Hauptwerk > HauptwerkUserData > OrganMIDIImplementationExports 

v5 and up: Hauptwerk > HauptwerkInternalWorkingFiles > GeneratedDocumentation  
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Inserting & Managing Hauptwerk Registration Changes 
Once a stoplist has been imported, you can right-click in the Detail View and select the menu 
item Insert Hauptwerk Registration. A window will then open with a list of checkboxes for 
each available register of the organ (couplers and tremulants are included). For example, the 
following list appears for the 1720 Bosch-Schnitger Organ from OrganART Media. 

 
If stoplists for multiple organs have been imported into MIDI Tapper, each organ is selectable 
using the popup menu at the top of the window. Registrations can be named, saved and 
recalled for each organ. Simply type a name into the Name field and click the Save button. 
Recall saved registrations by clicking the triangle to the left of the Name field. 

An inserted Hauptwerk registration gets connected to the nearest existing tap. For modern 
electric-action organs having pistons, this may be fine since it is normal to press a piston 
button to change registration at the same time notes are played; however, mechanical organs 
do not have such pistons and require reaching over and pulling or pushing stops, which are 
often heavy, so to maintain realism, registration changes for these organs should be kept 
separate from note events with reasonable time in between note events to simulate the 
physical effort required to make the changes. Separate an already inserted registration from 
existing note taps, simply right-click where you want the registration change to occur 
(somewhere between note taps) and select Insert Empty Tap. To move the registration to the 
empty tap, hover over the blue MIDI DIN icon representing the registration until the grabbing-
hand icon appears, then click and drag the registration to the newly inserted empty tap. A 
blue box outlines the destination as you drag the event. 

An existing registration can be edited by right-clicking the blue MIDI DIN icon and selecting 
the menu item Edit Hauptwerk Registration. 
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Preparing an Imported MIDI File for Hauptwerk 
Many tedious tasks are done at once when you click on the Tracks toolbar item and select 
Prepare for Hauptwerk. The tasks done are as follows: 

• Tracks are renumbered by voice range 

• Channels are numbered “intelligently” according to how many Tracks are present 

• An Empty Tap + Hauptwerk Registration is inserted as the first tap 

The following sections explains why these things are done and will help you understand how 
to prepare your MIDI files better for use with MIDI Tapper and Hauptwerk. 

Hauptwerk & MIDI Channels 
Hauptwerk assigns a unique MIDI channel to each division of each organ, numbering up from 
the bottom, Pedal = channel 1, lowest Manual = 2, etc., which is logical but does not 
correspond to the way MIDI files are structured. The data in MIDI files is organised into Tracks 
and Channels, usually numbered in the reverse order. Hauptwerk only recognises Channels, 
and Track information is completely ignored. Because of this, MIDI files need to be specially 
prepared for Hauptwerk. 

Organ music is usually written on three staves, normally represented in a MIDI File as three 
Tracks. Unless the maker of a MIDI file manually assigns MIDI channel numbers, each Track will 
use the same default MIDI channel 1. Sometimes Tracks may also be numbered in a confusing 
order, in which case clicking on the Tracks toolbar item and selecting Order Tracks by voice 
range will fix the problem. Hauptwerk expects three different channels, so these often need 
to be renumbered, which can be done by clicking on the Tracks toolbar icon and selecting 
Auto-Number Channels per Track. All the notes on Track 1 will be assigned to channel 1, all 
the notes on Track 2 will be assigned to channel 2, and so on. 

Swapping Hauptwerk Manuals 
Sometimes when deciding a registration, you may want to simply swap the manuals (for 
example, this can happen when looking for the best solo stop for a chorale-based piece). 
Click on the Tracks toolbar item and select Swap Hauptwerk Manuals. It is assumed that you 
are working with a two manual instrument, so what this function does is to swap the channel 
assignments for notes on channels 2 and 3, regardless of which tracks they are on. 

Additional Features  
The features implemented so far in MIDI Tapper to support Hauptwerk should be enough for 
most users, but you may find something missing that you need. Additional Hauptwerk features 
can be requested using the menu item MIDI Tapper > Request a Feature. 
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18. Sequences 
A Sequence may be used to automatically play back an assigned portion of source data, or a 
portion of corresponding recorded take data. This is useful when a passage is very difficult or 
impossible to tap. When a Sequence is defined, a tap serves as a Trigger to begin automatic 
playback of the selected data. During Sequence playback, a MIDI CC such as Modulation can 
be used to shape Note ON Velocities, and MIDI Pitch Bend can be used to control the tempo of 
the Sequence playback. When a Sequence ends, tapping resumes normally. Below is an 
example project showing a burst of MIDI data that would be impossible to tap in real time. 

 

Setting a Sequence 
To define a Sequence, follow these steps: 

1. Select a group of notes to define as a sequence. Every single note does 
not need to be selected. You may select only a first note and last note, and 
MIDI Tapper will automatically select all the other notes in between those 
two selected notes to assign to the Sequence. Chapter 7 outlines different 
ways that notes can be selected which can save you time. Use whatever 
method works best for the given situation.   
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2. With the defining notes selected, Right-Click any blank area of the Detail 
View and choose the menu item Sequence > Set Sequence. If you have 
recorded takes, the option appears both under the Current Take menu and 
the Source Data menu. 

3. The Sequence Window will appear to set the details of the Sequence. 

Sequence Window 
In the Sequence Window, the Source refers to which take 
is to be used for the Sequence. If you have opened the 
window from the Current Take menu, the Source will be 
set to the current take.  

Note ON Velocities may be controlled using a MIDI CC by 
replacing or scaling the values from the Source. Pitch 
Bend control of playback Tempo is also optional.  

The sequence may end with a Note ON event, or a Note 
OFF event, and any hanging notes within the sequence 
will be turned off automatically when playback ends, 
unless you choose to allow notes to hang.  

The button Make Default assigns the currently selected settings as default options for new 
sequences. Other default options for Sequences are also available in the Preferences window. 

Source 
A Take may be assigned to a Sequence only if at least one note in the sequence exists in the 
take. If any notes in the Sequence do not exist in the Take you attempt to assign to a 
Sequence, a warning window appears telling you that notes are missing. All notes assigned to 
the Sequence cannot be tapped, but those notes which are missing from the Take will remain 
unassigned and must be tapped. So whereas a missing notes warning would seem to be good 
reason not to assign that Take to that Sequence, there may be cases where you want to 
intentionally leave notes out of the Sequence playback, so that you can tap them manually 
along with the Sequence, which is why the option remains available. 

Velocity 
If you have selected either of the checkbox options in the Sequence Window, you will be able 
to shape the velocities and / or the tempo of the Sequence playback. For velocity control, 
incoming CC values can be mapped directly using the menu option Replace, so if a CC value 
of 60 is received, all notes in the sequence are assigned a velocity value of 60 until the next 
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CC message is received. The Scale option uses the CC value as a percentage scaling of the 
original value. So, if the original value is 70, a CC value of 127 will produce that value at 
100%, and a CC value of 64 will produce a value of 45, the original value at 50%. 
 

Depending on your MIDI output destination, using CC input during 
tapping when a Sequence is not playing back could alter playback 

in an unwanted way, for example using CC1 Modulation may add a vibrato to the sound. To 
stop this from happening, an option has been added to the Preferences window on the 
Tapping page to Filter out non-Sustain Pedal CCs when Tapping normally. 

Tempo 
The Pitch Bend option will control tempo as a scaling factor between 1/2 and 2: centre bend 
is the original tempo, full bend up is twice as fast, and full bend down is half speed. When 
this option is checked, if a Pitch Bend value has been received before a Sequence begins its 
playback, the Sequence will begin with that tempo scaling. 

End 
The sequence can end with the MIDI Note ON event or the MIDI Note OFF event from the last 
selected note. If you choose the Note ON option, this means that the last note (and any other 
notes beginning at the same time) will be sounding when sequence playback ends. All other 
notes within the sequence will be turned off at the end of sequence playback, unless you 
choose to allow hanging notes, in which case turning off sounding notes is handled by tapping 
after playback ends. 

Sequence Preferences 
Every Sequence Trigger is marked by a play-button icon. Apart from this, the appearance of a 
sequence depends on which options you have selected in the Preferences window. 
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Sequence Markers & Text 
Markers and Text may be added automatically when you set a Sequence. A Marker may be 
added at the start of the Sequence (at the Trigger Tap). Visually this is not really necessary, 
because the Trigger is already clearly marked by a Play icon, but a Marker at this point can 
aid in navigation, especially if you are working with many Sequences. A Marker at the end of a 
Sequence is visually helpful because there is no default cue marking the end of a Sequence, 
and it is important that you be ready to continue tapping at the point the Sequence ends. A 
Text option allows you to easily name Sequences or make quick performance notes. Note that 
these objects are not linked to the Sequence internally. 

Display scrolling refresh rate 
This parameter refers to how often the Detail View is to be updated when sequences are 
playing back. This number should be less than 20 for computers having slower processors or 
older graphics hardware. 20 should be adequate for normal purposes. When you increase the 
number, the screen will refresh more often, which may slow down playback, depending on 
how large the screen is and how complex the data is. 

Editing Sequence Parameters 
Clicking on the play icon displays a popup menu showing the details for the sequence with 
options to edit or delete it. Selecting Edit opens the Sequence window, in which you can 
select which take to play back for the Sequence. This is especially useful for shaping the 
sequence data. A sequence is recorded the same way that tapped MIDI is recorded, so it is 
possible to Sequence raw source data and shape the Note ON velocities, and then reassign the 
that recorded take to the Sequence. Since the Tempo setting of the source take is respected 
when the Sequence plays back, you can record a Sequence with shaped velocity, tweak its 
tempo, and then reassign that take to the Sequence. 
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Deleting a Sequence 
A Sequence may be removed at any time by following these steps: 

1. Select any (does not need to be all) of the notes belonging to the Sequence. 

2. Right-Click and choose the menu item Sequence > Unset Sequence (if you 
have recorded takes, you may need to select the Source Data submenu). 

Note that any Markers and Text which were automatically added to the Sequence when 
it was set will not be removed, because these objects are not internally linked in any 
way to the Sequence. 
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19. Project File Handling 
In the Preferences Window you will find a list of options for the behaviour of MIDI Tapper 
when you quit the application. 

 

Auto store unsaved projects internally 
Check this option if you would like open projects that have not been saved to be stored 
automatically when you quit. You can then work without having to manage external project 
files at all, which may be more convenient in some cases. The project files will instead be 
stored in the following location: 

/Users/UserName/Library/Application Support/MIDI Tapper/Sessions/ 

If you purchased MIDI Tapper from the Mac App Store, the above location exists inside your /
Users/Username/Containers directory. Note that project files which have been opened as 
external files will not be stored internally, but rather will be stored at the location of the 
external file. 

Restore external projects at next session 
Check this option if you would like all open projects to be reloaded automatically the next 
time you open MIDI Tapper. MIDI Tapper will then store the paths to open projects in a file 
called projectpaths.xml in the directory listed above. When using this option, be aware that 
if you move your project files around after quitting MIDI Tapper, the paths will no longer 
match and the moved files will not be opened when you reboot MIDI Tapper. 

Prompt to handle each open project 
Check this option if you want to use the above automatic project saving and loading options, 
but also want to have control over exactly what will happen to each project when you quit. A 
dialog will then appear for each window asking you what you want to do with that project. 
This is the default behaviour. 

Discarding a Project 
When using the automatic options described above, MIDI Tapper gives you options to save 
projects internally or externally. If you want to discard the file, select Options, and select 
Discard, or choose Save Externally, cancel that operation, and then close the window. 
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APPENDIX: Supported Tuning File Types 
MIDI Tapper supports seven types of tuning files. The file extension must be included with the 
file name in order for the file to be visible to MIDI Tapper. 

.scl  
The Scala format is by far the most widely used and widely available tuning files. For details 
on this format and how to use it, see http://www.huygens-fokker.org/scala/scl_format.html 

.csv  
This is a file format used by H-Pi Instruments Custom Scale Editor (CSE), Tonal Plexus Editor 
(TPXE), and H-Pi Lo-Fi Microstudio (HPLF) software. These files consist of comma-separated 
lists of MIDI bytes as MIDI NOTE, PITCH BEND MSB, PITCH BEND LSB. In a .csv file, there is no 
information concerning a scale as such. The files may list 128, 512, or 2048 values. A list of 
128 values is a tuning for one MIDI channel. A file listing 512 values covers 4 MIDI channels of 
128 notes each. The 512 tone files are used by CSE for Tuning Box TBX1 hardware, which 
supports tunings in four layers, one layer per MIDI channel. 2048 values covers all 16 MIDI 
channels, used by TPXE for Tonal Plexus keyboards, where each physical octave of the 
keyboard is mapped to two MIDI channels. 

.hz  
This is a file format used by H-Pi Instruments H-Pi Lo-Fi Microstudio (HPLF), also supported 
by CSE, TPXE as an export format. They are text files consisting of a simple list of frequency 

.scl text list of tones as scales in ratio or decimal form

.csv text list of 128, 512, or 2048 MIDI Note + 14-bit Pitch Bend values

.hz text list of 128, 512 or 2048 Hz values

.tun text list of 128 cents values

.mtx text list of frequency values with other special information

.gly binary file exported from Absynth (Native Instruments)

.tonex text list of scale tones in a variety of formats using xml tags
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values in Hz. The numbers of tones listed in the file correspond to the same options listed 
above for .csv files; that is, 128, 512, or 2048. 

.tun  
These files are also known as VAZ-Anamark files, and can exist in a few different varieties, 
but the majority of these file consist of a list 128 cents values. The cents values are given in 
reference to the lowest MIDI note 0, and this form of the file contains no scale information as 
such. More information on this format can be found at http://www.mark-henning.de. 

.mtx  
These files are created by Max Magic Microtuner software. Details on this format can be found 
at http://digilander.libero.it/microtuner/MicrotunerFormat.pdf. 

.gly  
These files are created by Native Instruments Absynth software, and the format is also 
exported by Scala (by Manuel Op de Coul), and CSE. Because .gly is a binary file, there are no 
public details on the file type, and it is impossible to make the file as text or to view the file 
contents as text, except in a hex editor. The file data itself is an encrypted list of 128 Hz 
values, one value per MIDI note. 

.tonex 
This is an experimental filetype supported by MIDI Tapper, which uses xml tags to specify 
different aspects of a tuning. MIDI Tapper supports simple .tonex files which list tones in scale 
order using tuning entries. 

Two sample files of each supported file format are included with MIDI Tapper. The files are 
installed in User/Music/MIDI Tapper in the following folders: 

• Tunings scl 
• Tunings csv 
• Tunings tun 
• Tunings hz 
• Tunings gly 
• Tunings mtx 
• Tunings tonex 
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Credits & Resources 

All versions of MIDI Tapper are designed and programmed by Aaron Andrew Hunt, using Xojo 
and MBS Plugins on a Mac. 

MIDI Tapper is conceptually based on the work of Stephen Malinowski, inventor of Music 
Animation Machine and Tapper music software, the forerunner and inspiration behind MIDI 
Tapper. 

This documentation is written by Aaron Andrew Hunt, using Apple Pages. 

Thank you for supporting H-Pi Instruments and MIDI Tapper. 

©2021 H-Pi Instruments · FOR THE FUTURE OF MUSIC
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